Confidential - Oracle Restricted

ORACLE

Confidential - Oracle Restricted

Oracle® Communications
LSMS

Full Upgrade Guide
Release 14.0
F91165-08

April 2025



Confidential - Oracle Restricted

Software Upgrade Procedure Full Upgrade for LSMS 14.0

Copyright © 2000, 2025, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and
are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not
use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any
form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for
interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors,
please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S.
Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed
on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to
the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure,
modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the
hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other
rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or
intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use
this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup,
redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages
caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective
owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and
are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are
trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information on content, products, and services from third
parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to
third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or
damages incurred due to your access to or use of third-party content, products, or services.

A CAUTION: Use only the guide downloaded from the Oracle Technology Network (OTN)
(http://www.oracle.com/technetwork/indexes/documentation/oracle-comms-tekelec-2136003.html).

Before upgrading your system, access the My Oracle Support web portal (https://support.oracle.com) and
review any Knowledge Alerts that may be related to the System Health Check or the Upgrade.

Before beginning this procedure, contact My Oracle Support and inform them of your upgrade plans.
Refer to Appendix E for instructions on accessing My Oracle Support.

Confidential - Oracle Restricted


http://www.oracle.com/technetwork/indexes/documentation/oracle-comms-tekelec-2136003.html
https://support.oracle.com/

Confidential - Oracle Restricted

Full Upgrade for LSMS 14.0 Software Upgrade Procedure
What’s New in This Guide

This section introduces the documentation updates for Release 14.0 in Oracle Communications LSMS Full Upgrade
Guide.

Release 14.0 — F91165-08, April 2025

e  Added step 3 in Procedure 6, Backup LSMS DB to disable LSMS backup on both A and B servers.

Release 14.0 — F91165-07, November 2024

e Added the command # rm -rf /var/TKLC/lsms/free/<regionDB> to extractthe snapshot data
from the archive tar files copied from LSMS in step 5 in Procedure 19, Restore Database.

e Updated the command to exchange key with remote ELAP and LSMS in step 4 and 5 in Procedure 22, SSH
Key Exchange between ELAP and LSMS.

e Removed step 7 from Procedure 22, SSH Key Exchange between ELAP and LSMS.

Release 14.0 — F91165-06, October 2024

Updated the note about valid licenses to be installed on LSMS A and B servers in the Procedure 16, TMN Toolkit and
Marben OSI License Installation section.

Release 14.0 — F91165-05, September 2024

e Added a note in step 7 in Procedure 6, Backup LSMS DB to take a note of EMS configuration.

e  Added information about editing the MySQLUserGrants.sql file in Procedure 6, Backup LSMS DB.

e Added information about a warning displayed during the upgrade in step 11 in Procedure 11, Install the LSMS
Application.

Release 14.0 — F91165-04, September 2024

Updated the Required Materials section to add reference to Release Notes to access the procedure to obtain the license
key files for Marben OSI and TMN Toolkit from Artifex for successful communication between LSMS and NPAC.

Release 14.0 — F91165-03, August 2024

e Updated the Required Materials section.

e Added a note in the Upgrade Timeline for LSMS Procedure Execution Order section.
e Updated the note in step 4 in Procedure 6, BACKUP LSMS DB.

e Updated step 8 in Procedure 6, BACKUP LSMS DB.

e Updated Procedure 10, Configure Network Interface Using Platcfg Utility.

)

)

[ )

[ )

Added a note in Procedure 15, Segmented Configuration for LSMS Cards.

Updated step 2 in Procedure 16, TMN Toolkit and Marben OSI License Installation.
Removed the Appendix “Procedure to Procure TMN and Marben Licenses”.
Replaced the reference to Appendix F with Appendix E throughout the document.

Release 14.0 — F91165-02, June 2024

e Added the procedure for SSH Key Exchange between ELAP and LSMS.
e Updated the reference to Procedure 22 in Timeline table for Maintenance Window Task.

Full Upgrade for LSMS 14.0
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1. INTRODUCTION

1.1Purpose and Scope

This document is designed to detail the steps necessary to upgarde the functionality of the LSMS 13.5.X. on ESAPPB-
02 to the LSMS 14.0.Y on the ESAPPB-02 cards.

This work is intended to be non-intrusive to the signaling network traffic and is to be performed within the limits of a
normally scheduled maintenance window unless otherwise stated.

It will be necessary to halt the provisioning activity during the execution of the procedures outlined herein while a full
database backup is being taken. Normal provisioning can resume once the full upgrade has completed. For any issues
incurred in executing any part of this document, follow the contact/escalation list.

The individual executing this procedure must be experienced and well proficient with the following platforms and
technologies.

e  Unix/Linux Admin

e VI Editor

e |P Networking

e  Oracle LSMS Platform E5-APP-B (TPD through Initial Implementation)

If you do not have these skills or if you are not completely comfortable working in Unix or Linux system environment,

STOP - DO NOT PROCEED
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1.2References
[1] Formal Peer Review, PD001866, latest version

[2]
[3]
[4]
[5]
[6]

Work Instruction Template, TM005023, latest version

Oracle Quality Manual, latest version

TPD Initial Product Manufacture User’s Guide, 909-2130-001, Latest revision, Oracle
ELAP 11.0 Full Upgrade/Installation Procedure, Current Version, Oracle
Query Server Installation and Upgrade Instructions, Latest Version, Oracle

1.3Acronyms

Table 1. Acronyms

BIOS Basic Input Output System

DB Database

E5-APP-B/ESAPPB Eagle5 Application Card class B cpu/board
E5APPB-02 E5 Based Application card installed with 480G SSD Hard Drive
ELAP Eagle LNP Application Processor

IPM Initial Product Manufacture

LSMS Local Service Management System

NAS Network Attached Storage

NPAC Number Portability Administration Centre
QS Query Server

SERVDI Support ELAP Reload Via Database Image
TPD Tekelec Platform Distribution

MPS Multi Purpose System

1.4 Definitions

Table 2. Definitions

Active LSMS

LSMS on which the sentry is running and it takes updates from the NPAC.

Standby LSMS

LSMS on which data is replicated from the Active LSMS.

System health check

performed using the TPD syscheck utility.

Procedure used to determine the health and status of the LSMS server, typically

Full Upgrade for LSMS 14.0
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1.5Terminology

Multiple servers may be involved with the procedures in this manual. Therefore, most steps in the written procedures
begin with the name or type of server to which the step applies. For example:

Each step has achechbor for every command within the sfep that the
fechricia shodd check fo kesp frade of the progress of the procedure.

The fifle box describes the operafions fo be performed during that sfep.

Each command fhat the fechnicianis fo enfer isin 9 point Lucida Console fonf

| \

1 | MPS A: Verify all | Materials are listed in Material List (Section 1.6)

D materials required
are present

Figure 1. Example of a step that indicates the Server on which it needs to be executed

1. | 1A | 1B | MPS X: Insert Insert media in USB drive
USB.
HEn

Figure 2. Example of a step that needs to be executed on both MPS A and MPS B servers

1.6Required Materials

e | SMS 14.0 works on OL8.x and needs license key files for Marben OSI and TMN Toolkit from Artifex for
successful communication between LSMS and NPAC. Make sure to get the two license key files from Artifex
before the scheduled upgrade date. Refer to LSMS 14.0 Release Notes, section 3.3: Marben OSI and TMN
Toolkit license key files, for details. Make sure to start the process at least 7 days before the scheduled upgrade
date.

e Two (2) target-release TPD USBs

e Two (2) target-release LSMS USBs or a target release LSMS ISO file.

e Aterminal and null modem cable to establish a serial connection.

e 100mbps link is required for database transfer to remote server.

¢ Remote Server or NAS server to store DB Backup before migration.

e TMN and Marben OSlI license for OL8 server

e Type of Network configuration single/segmented

e  System configuration information like NTP Server IP, App IP, ELAP IP etc.
Write down the system configuration information.
App IP:
App Gateway:
NTP Server IPs:
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ELAP Server IPs:

NPAC Server IPs:

NPAC Customer ID:

NMS IPs:

Other IPs required:

Remote Server IP to copy DB Backup:

e Passwords for users on the local system:

Software Upgrade Procedure

LSMS USERS

login

MPS A password

MPS B password

Ismsmgr

Ismsadm

Ismsall

Ismsuext

Ismsuser

Ismsview

root

mysql dbroot user

admusr

Command-line

Table 3: User Password Table

Note: After the MPS servers are IPM’ed with TPD 7.5.x, then “root” user access is disabled. “admusr” can be used if
required to access the MPS servers. After the installation of LSMS application the “root” user access is again enabled.

Full Upgrade for LSMS 14.0
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1.7E5APPB Server (Rear

Figure 3. E5-APP-B Server (Rear)

1.8 Switch Configuration

VLAN configuration on the switch is done based on the LSMS/NAS Segmented Type Configuration. Please note that
the VLAN IDs can be different based on the LAB network configuration.

Name [VTag| Rout If | Tagged ports | Untagged ports

default |1 | swO | [1/1/1-1/1/24

vlan2 |2 | [1/1/3,1/1/4 |

vlan3 |3 |[1/1/3,1/1/4 |

naspri-network |5 | |1/1/3,1/1/4,1/1/17 |
nassec-network |6 | |1/1/3,1/1/4,1/1/18 |
elap-network |159 | |1/1/3,1/1/4,1/1/19 |
gui-network |161 | |1/1/3,1/1/4,1/1/20 |

Optionally assign some name to the switch ports:
interface 1/1/3

name LSMS-A_NAS/ELAP/GUI

!

interface 1/1/4

name LSMS-B_NAS/ELAP/GUI
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interface 1/1/17

name LSMS-A_NAS-pri
!

interface 1/1/18

name LSMS-B_NAS-sec
!

interface 1/1/19

name ELAP-network-uplink
!

interface 1/1/20

name Gui-network-uplink

1.9Fallback
If for any reason a fallback to the original configuration is required, the procedure will be to re-IPM the server and
install the old LSMS version.

Full Upgrade for LSMS 14.0
14.0 13 of 100
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2. GENERAL DESCRIPTION
This document defines the step-by-step actions performed to execute a software full upgrade to ESAPPB-02.

The LSMS application can be installed, or upgraded based on the table below.

Table 4 Install-Full Ugrade paths for ESAPPB-02

TPD Release for IPM LSMS Initial Installation Release
8.6.0.2.0_110.14.0 or later 14.0.Y

Full upgrade Source Release Full upgrade Destination Release
13.5.X 14.0.Y

*Note : LSMS 14.0.Y is supported on ESAPPB-02 cards only

The LSMS upgrade paths are shown in the figures below. The general timeline for all processes to perform a software
upgrade, from pre-upgrade backups to a final system health check, is also included below.

This document covers
migration from LSMS 13.5;to
LSMS 14.0

LSMS 13.5x-yyy |™mmm . LSMS 14.0 .a-b.b.b

on an ESAPPB-02 Migrate on an ESAPPB-02

Figure 4: Full upgrade Path - LSMS 13.5.X to 14.0.Y

Confidential - Oracle Restricted



Confidential - Oracle Restricted

Full Upgrade for LSMS 14.0 Software Upgrade Procedure

3. FULL UPGRADE PROCEDURES
3.1 Upgrade Timeline for LSMS Procedure Execution Order

NOTE: Before starting the procedure make sure you have all the required information listed in section 1.6. Do
not proceed further until youy have this required information, missing any information will be fatal post
upgrade.

3.1.1.1 Preparation phase

Before planning or starting Full Upgrade to LSMS 14.0 customer will have to procure TMN and Marben
Licenses for NPAC connection to work on OL8 post upgrade. Contact My Oracle Support (3.7Appendix E) to
procure the licenses.

Table 5: Timeline table for full upgrade preparation

LSMS 1A LSMS 1B
Procedure Task 1A | Task 1B Task Procedure
Start
time
(min)
Procedure 1 Setup upgrade environment 5 0
5 5 | Setup upgrade Procedure 1
environment
Procedure 2 Pre Full upgrade Health 5 10 5 | Pre Full upgrade Health | Procedure 2
Check Check
Procedure 3 Verify LSMS QS 10 20
30

3.1.1.2 Maintenance Window Tasks

Table 6: Timeline table for Maintenance Window Task

LSMS 1A LSMS 1B
Procedure Access Task 1A | Task | 1B Task Access Procedure
Method Start Method
time
(min)
Direct Disconnect 10 0
Procedure 5 SSH NPAC from
LSMS
Procedure 4 Disconnect
ELAP from
LSMS
Procedure 6 Direct Backup LSMS 120 10 10 | IPM MPS B Minicom | Procedure 8
SSH DB 0 | server and NAS mate for
server MPS B
Transfer and
Procedure 7 Database to Minicom
Remote Server nas for
NAS
server
Full Upgrade for LSMS 14.0
14.0 15 of 100
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Pre-Install Minicom | Procedure 9
Configuration mate
Install the Minicom | Procedure 11
Application mate
Configure Minicom | Procedure 10
Network mate

interfaces using
platcfg utility

Configure Time | Minicom | Procedure 13
Zone and Clock. | mate

TMN Toolkit Minicom | Procedure 16
and Marben OSI | mate

License
Installation
Procedure 8 Minicom | IPM MPS A 60 130
mate server
Procedure 9 Pre-Install
Configuration
Procedure 11 | Minicom | Install the 25 190
mate Application
Procedure 12 | Minicom | LSMS Initial 15 215
mate Configuration
Procedure 13 | Minicom | Configure Time 5 230
mate Zone and Clock.
Procedure 14 | Minicom | Network 10 235
OR mate Configuration
Procedure for LSMS Cards.
15Error!
Reference *Note: For
source not Single Subnet
found. Configuration
execute
Procedure 14
and for
Segmented
Subnet
Configuration
execute

Procedure 15.

Procedure 16 | Minicom | TMN Toolkit 5 245

mate and Marben OSI
License
Installation
Procedure 17 | Minicom | Start LSMS 10 | 250
mate services
Procedure 18 | Minicom | Post 5 260
mate Configuration
Health Check
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Procedure 19 | Minicom | Restore Database | 60 | 265
mate
Procedure 20 | Minicom | Connect LSMS 15 | 325
mate 14.0.X to NPAC
Procedure 22 | Direct SSH Key 15 | 340
SSH Exchange
Between ELAP
and LSMS
Procedure 23 | Minicom | Connect LSMS 10 350 5 | Accept the Direct Procedure 24
mate 14.0.X to ELAP upgrade SSH
Procedure 24 | Minicom | Accept the 5 355
mate upgrade
Upgrade 355
Completed

3.1.1.3 Post Upgrade Phase

LSMS 1A LSMS 1B
Procedure Task 1A | Task 1B Task Procedure
Start
time
(min)
Procedure 21 | Export the Database from 60 0
LSMS 14.0.X to the Query
Server
60

3.2Install Procedures

This procedure will be executed for customers who are installing LSMS application on new server or are not using
LSMS application before this release. All other customers migrating from 13.5 release will have to follow Full Upgrade
Procedure.

3.2.1.1 Maintenance Window Tasks

Table 7: Timeline table for Maintenance Window Task

LSMS 1A LSMS 1B
Procedure Access Task 1A | Task | 1B Task Access Procedure
Method Start Method
time
(min)
Procedure 8 Direct IPM MPS A 120 0 0 | IPMMPSB Direct Procedure 8
Serial/Mi | server server and NAS Serial/Mi
nicom server nicom
Connecti Connecti
on on
Procedure 9 Pre-Install Pre-Install Procedure 9
Configuration Configuration
Full Upgrade for LSMS 14.0
14.0 17 of 100
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Procedure 11

Procedure 13

Install the
Application

Configure Time
Zone and Clock.

Install the
Application

Configure Time
Zone and Clock.

Procedure 11

Procedure 13

Procedure 12 | Direct LSMS Initial 15 120
Serial/Mi | Configuration
nicom
Connecti
on
Procedure 13 | Direct Configure Time 5 135
Serial/Mi | Zone and Clock.
nicom
Connecti
on
Procedure 14 | Direct Network 10 140
OR Serial/Mi | Configuration
Procedure 15 | nicom for LSMS Cards.
Connecti
on *Note: For
Single Subnet
Configuration
execute
Procedure 14
and for
Segmented
Subnet
Configuration
execute
Procedure 15.
Contact Procure Procure TMN - - | Procure TMN Procure Contact
Oracle TMN License License TMN Oracle
Support License License Support
Note: Timing to Note: Timing to
accuire TMN accuire TMN
license may wary license may
depending on wary depending
Artifex team on Artifex team
availability. availability.
Procedure 16 | Direct TMN Toolkit 5 150
SSH and Marben OSI
License
Installation
155 5 | TMN Toolkit Direct Procedure 16
and Marben OSI | SSH
License
Installation
Procedure 17 | Direct Start LSMS 10 | 160
SSH services
170 10 | Start LSMS Direct Procedure 17
services SSH
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Direct Post 5 180
Procedure 18 | SSH Configuration
Health Check
185 5 | Post Direct Procedure 18

Configuration SSH
Health Check

Procedure 20 | Direct Connect LSMS 15 190

SSH 14.0.X to NPAC
Procedure 23 | Direct Connect LSMS 10 205 5 | Accept the Direct Procedure 24
SSH 14.0.X to ELAP upgrade SSH
Procedure 24 | Direct Accept the 5 215
SSH upgrade
Upgrade 220
Completed

3.3Pre Full upgrade Steps
Check off (V) each step as it is completed. Boxes have been provided for this purpose under each step number.

Should this procedure fail, Contact My Oracle Support following the instructions on the Appendix E.
Procedure 1 SETTING UP FULL UPGRADE ENVIRONMENT

Procedure 1 - Setting Up Full upgrade Environment

This procedure sets up the full upgrade environment.

Estimated time: 5 minutes

¥+OoOm-Hw
>
w

MPS X: SSH to MPS IP:

L. HE RN ; Togin: root
Login as root to MPS Password: <root_password>

. Start a capture file using Iso Console, or by
MPS X: . ; .
2 O O ] starting a local screen session and capturing
Start capture file. 1ts output.
MPS X:

3 Ol O Acgess mate MPS via # minicom mate
serial console

console Togin: root

mate MPS: Password: <root_passwords

Login as root.

This procedure is complete!

Procedure 2 PRE-FULL UPGRADE SYSTEM HEALTH CHECK

Note: This procedure may be executed outside of the maintenance window.

Full Upgrade for LSMS 14.0
14.0 19 of 100
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Procedure 2 — Pre-Full upgrade System Health Check

Verify that the ACTIVE
server’s MySQL replication
is functioning properly.

? This procedure determines the health of the MPS before and after full upgrade.
5 Estimated time: 5 minutes
#
1. | MPS Aand B: Login to Login: 5901' d
- the server as the user “root”. | Password: <root_password>
i # date
2. | MPS Aand B: Thu May 12 05:55:27 EDT 2016
| Validate date, time and time
zone to ensure accuracy.
3. | MPS A and B: Execute the following command on both LSMS A and B to verify the HA state of
]| Execute the “hastatus™ mated LSMS pair.
command-to verify the HA # hastatus
state of this server.
Verify that the hastatus of one of the servers is Active and the other is Standby.
WARNING: If the output from the above command is anything else other than
“ACTIVE” and “STANDBY”, do not proceed with this procedure and contact My
Oracle Support following the instructions on the Appendix E.
4. | LSMS Standby server: Executtle the fﬁllowing command to verify.that MySQL replication is working
| Verify that the STANDBY correc.t y on the STANDBY LSMS server:
server’s MySQL replication | # tail /var/TKLC/1sms/logs/dbrepiMon.log
is functioning properly. If MySQL replication is functioning correctly then the following output will be
observed, make sure that at least the last line of your output matches the lines
below.
Thu Dec 07 05:58:12 2017 A1l tests passed on STANDBY
Thu Dec 07 05:59:19 2017 ATl tests passed on STANDBY
Thu Dec 07 06:00:25 2017 Al1 tests passed on STANDBY
Thu Dec 07 06:01:32 2017 ATl tests passed on STANDBY
WARNING: If at least the last line of your output does not match the lines above
then do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.
5 | LSMS Active server: Execute the following command to verify that MySQL replication is working

correctly on the ACTIVE LSMS server:
# tail /var/TKLC/1sms/logs/dbreplMon.Tog

If MySQL replication is functioning correctly then the following output will be
observed, make sure that at least the last line of your output matches the lines
below.

07 05:58:12 2017 A1l
07 05:59:19 2017 A1l
07 06:00:25 2017 A1l
07 06:01:32 2017 A1l

Thu Dec
Thu Dec
Thu Dec
Thu Dec

ACTIVE
ACTIVE
ACTIVE
ACTIVE

tests passed on

tests passed on
tests passed on

tests passed on
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Procedure 2 — Pre-Full upgrade System Health Check

WARNING: If at least the last line of your output does not match the lines above
then do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.

MPS A and B:
| Execute syscheck

o

# syscheck

Running modules in class disk...
OK

Running modules in class services...

OK
Running modules in class system...

OK
Running modules in class TIsmshc...

OK

Running modules in class hardware...

OK
Running modules in class proc...

OK
Running modules in class net...

OK

LOG LOCATION: /var/TKLC/log/syscheck/fail_log

LSMS Active server:

]| Capture the output of
‘sentry status’ command

~

Execute the following command on the ACTIVE LSMS server to display the
current LSMS sentry status:

# sentry status
NOTE: Verify that the output displays a Status of “running” for all processes; the
regional processes (npacagents) may or may not be associated in the Comment

field. If the output from this command displays any other Status than “running”
contact My Oracle Support following the instructions on the Appendix E.

Capture the output from this command and make it available to Oracle Technical
Services if required.

8. | LSMS Active server:

SSH to NAS server and
execute syscheck.

# ssh backupserver
# syscheck

Running modules in class disk...
OK

Running modules in class services...

Full Upgrade for LSMS 14.0
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OK
Running modules in class system...

OK
Running modules in class 1smshc...

OK
Running modules in class hardware...

OK
Running modules in class proc...

OK
Running modules in class net...

OK

LOG LOCATION: /var/TKLC/log/syscheck/fail_Tlog

Note down the Timezone

©

Note the timezone which will be required to be configured post upgrade.

# su - Tsmsmgr

Select Server Configuration and press [ENTER].
Main Menu |

Maintenance
Diagnostics

Initial Configuration

Server Configuration
Network Configuration
Exitc

Time
Exit

LOne

Set Clock

Select Time Zone and press [ENTER].
| Server Configuration Menu |

The screen shows the current time zone setting.
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tz affiliates. RlGGGErI IR e

[noggggggeagggdadaaaaa’

10.| Repeat on the day of the
H scheduled full upgrade

All Health Checks should be repeated the day of the full upgrade. If any problems
are encountered, resolve before proceeding further.

This procedure is complete!

Procedure 3 VERIFY LSMS QUERY SERVER

Procedure 3 - Verify LSMS Query Server

] Verify if the Query Server
Feature is active on the
LSMS System.

? This procedure determines if the LSMS 13.5 has an Optional Query Server.
E . . .
p | Estimated time: 10 minutes
#
1. | LSMS Active server: Login: 1smsadm
Log in to the server as the | Password: <1smsadm_password>
user “Ismsadm”.
2. LSMS Active server:

$ /usr/TKLC/1sms/tools/1smsdb -c queryservers
/usE{TﬁLc/'lsms/too1s/1smsdb: Query Server Feature 1is not
enabled.

___OR___

cs2-bss2 (<LSMS Query Server IP>) Connected
___OR___

cs2-bss2 (<LSMS Query Server IP>) Disconnected

3. LSMS Active server:

] | Note down the Query
Server IP Address (es).

If the Query Server exists on the LSMS System, note the IP address (es) for later use.

This procedure is complete!

3.4Data Backup before Full upgrade

Procedure 4 DISCONNECT ELAP FROM LSMS

Procedure 4 - Disconnect ELAP from LSMS

| ? | This procedure disconnects the ELAP from LSMS.
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Procedure 4 - Disconnect ELAP from LSMS

g Estimated time: 5 minutes

# | Note: This procedure needs to be executed on all the connected ELAPs.

—_

ELAP Active server: NOTE: Verify the following.
[] | Verify ELAP 10.2 install ) ] ]
1. ELAP 10.2 is successfully installed and configured.

2. ELAP 10.2 is connected to Eagle for data download

N

LSMS Active server: Login: 1smsadm

] | Log in to the server as the Password: <1smsadm_password>
user “Ismsadm”.

3. | LSMS Active server: $ eagle status

[] Eli_sz‘;””ea the connected Look for all connected ELAPs and disconnect each of them.
s

$ eagle stop <ELAP CLLI>
eagle: Stopping...
eagle: eagleagent STPA stopped at Tue Apr 26 05:48:52 2023

4. ELAP Active server:

7 | Login to ELAP GUI Login to the ELAP (connected to LSMS) GUI through VIP as uiadmin.

5. ELAP Active server:

[ | Disable the Bulk Download Go to menu Maintenance -> LSMS HS Bulk Download -> Change Enabled

Click on ‘Disable LSMS Bulk Download for this ELAP’ button.

ELAP_A_NAME Change LSMS HS Bulk Download Enabled

i INFO: The LSMS Bulk Download for this ELAP is currently Enabled.

A CAUTION: This action will Disable the LSMS Bulk Download for this ELAP.

I Disable LSMS Bulk Download for this ELAP

2013 © Tekelec, Inc., All Rights Reserved.

ELAP_A_NAME Change LSMS HS Bulk Download Enabled

“ SUCCESS: The LSMS Bulk Download for this ELAP is now Disabled

2013 © Tekelec, Inc., All Rights Reserved.

6. | ELAP Active server: Got Maint LSMS C i ch Enabled
. 0 to menu Maintenance -> onnection -> ange enable
O ([:):)S:r?;itm LSMS Click on ‘Disable LSMS Connection’ button.

ELAP_A_NAME Change LSMS Connection Allowed

.
1 INFO: The LSMS Connection is currently Enabled.

& CAUTION: This action will Disable the LSMS Connection.

Disable LSMS Connection

2013 © Tekelec, Inc., All Rights Reserved.

ELAP_A_NAME Change LSMS Connection Allowed

V SUCCESS: The LSMS Connection is now Disabled

2013 © Tekelee, Inc., All Rights Reserved.
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7.

[l

All connected ELAPS:

Disconnect LSMS
connection

Repeat the steps 4 to 6 for all ELAPs connected to LSMS.

This procedure is complete!

Procedure 5 DISCONNECT NPAC FROM LSMS

Procedure 5 - Disconnect NPAC from LSMS

This procedure disconnects NPAC from LSMS.

Estimated time: 5 minutes

|:| — [ om—aw

LSMS Active server:

Log in to the server as the
user “Ismsadm”.

Login: Tsmsadm
Password: <1smsadm_password>

RS

LSMS Active server:

Stop all connected NPAC
regions

Execute the followin_lg command to list the active NPAC regions
$ dbnames -n all -a

Canada CanadaDB

MidAtTantic MidAtTanticDB

Midwest MidwestDB

Northeast NortheastDB

Southeast SoutheastDB

Southwest SouthwestDB

WestCoast WestCoastDB

western WesternDB

Note: The above output shall vary depending on LSMS configuration.
Note: Store this output as it will be required during DB restore phase post

upgrade.

Execute the following command to stop an NPAC region.
$ 1sms stop <region name>

Checking if npacagent 1is running....Yes.

Stopping npacagent....
OK.

npacagent stopped: Wwed Jan 2 05:52:42 2014

Ccommand complete.

Execute the above command for all active regions.

LSMS Active server:
Login to LSMS GUI

Login to LSMS Active GUI through VIP as ‘Ismsall’ user.

FS

LSMS Active server:
Deactivate all active regions

Click on the NPAC region.
Go to the menu Configure -> LNP System -> NPAC -> Modify -> Primary
Uncheck the ‘Activate Region’ checkbox and click ‘OK”’.
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Procedure 5 - Disconnect NPAC from LSMS

7w Modify LNP System NPAC <Canada, primary:> [z

SMS Name [Regions MPAC Canada Activate Region

Address Info | Component Info Contact Info | Comm Info
MPAC D5 Address

PSEL |ow? SSEL |ow7 TSEL NSAP {10 248 |10 |5

LEmS OS] Address

PSEL pzel 55EL ssel TSEL NSAP 10 248 10 78

MPAC FTP Address

100|248 |10 |5

E Modify NPAC Component?

OK Cancel

Note: Similarly, Deactivate all the active NPAC regions.

This procedure is complete!

Procedure 6 BACKUP LSMS DB

Procedure 6 - Backup LSMS DB

? This procedure outlines the steps to backup the LSMS DB.
E | Estimated time: 90 minutes
P
# | NOTE: The estimated time may differ depending on the DB size.
; . Login: root
- LSMS Active server: Password: <root_password>
] | Log in to the server as the
user “root”
2. LSMS Active server: # 1smsdb —c counts
[ ] | Record DB counts
3 LSMS Active and Standby | Run the following command on both LSMS A and B to disable LSMS backup:
[ ] | Server: Disable LSMS .
# sed -i "/A#/! {/1smsbkp_wrapper/ s/A/#/}'
backup on both A and B /etc/cron.d/1smsbkp.cron
servers
4. LSMS ACt'_"e_ Server. # rm -rf /var/TKLC/1sms/free/mysql-snapshot-*
[ | Remove existing DB # rm -rf /var/TKLC/1sms/free/snapinfo.sql
snapshots
5 LSMS Active server: Execute below command to verify “QUERY_SERVER” and
[ “RESYNCDB QUERY_ SERVER?” feature is enabled:
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Enable
“QUERY_SERVER” and
“RESYNCDB_QUERY S
ERVER” Feature

Note: Even if Query Server
is not connected this step is
required to take backup

# Tsmsdb -c features | grep —w QUERY_SERVER
# 1smsdb -c features | grep -w RESYNCDB_QUERY_SERVER

If these features are not enabled then execute the below commands to enable them:

# su - Tsmsadm

$ dbcfginternal QUERY_SERVER Y
Provide the “Customer Service ID”

$ dbcfginternal RESYNCDB_QUERY_SERVER Y
Provide the “Customer Service ID”

$ exit

o

LSMS Active server:
Backup the LSMS DB

# 1smsdb -c snapshot

WARNING: This command may cause a brief interruption in
traffic being sent from the NPAC to connected network
elements and local LSMS provisioning may be INTERRUPTED.

Do you want to continue? [Y/N]Y

Creating snapshot of the database partition, please wait...

File descriptor 5 (socket:[34104267]) leaked on lvcreate

invocation. Parent PID 28676: /usr/TKLC/1sms/tools/1smsdb
Logical volume "dbbackup" created

The database is available to the application again.

Disk snapshot created successfully.

Snapshot mounted successfully.

Created snapinfo.sql file successfully

MidAtlanticDB/

MidAtlanticDB/NumberpPoolBlock.frm

MidAtlanticDB/ServiceProvNetwork.MYD

Logica] volume "dbbackup" successfully removed

Note: The execution time of the above command shall vary according to the DB
size.

Verify that the following snapshot files are created at /var/TKLC/Isms/free
directory:

e mysql-snapshot-noreplDB.tar.gz

e mysql-snapshot-supDB.tar.gz

e mysql-snapshot-<regionDB>.tar.gz

e snapinfo.sql

~

LSMS Active server:

Verify the snapshot files for
all existing NPAC regions

Execute the following command and verify that the snapshot files are created for
all the NPAC regions listed in the command output.
Note: The below command shows only the regions for which the DB exists.

# 1smsdb -c dblist
CanadaDB
MidAtTanticDB
MidwestDB
NortheastDB
Rep1TestDB
SoutheastDB
SouthwestDB
wWestCoastDB
westernDB

TogDB

mysq1l

norep1DB
performance_schema
SupDB
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Procedure 6 - Backup LSMS DB

8. LSMS Active server: . i
Run the following command on LSMS Active server CLI to take MySQL dump of
[ | Take MySQL dump of the supDB database.
supDB.
# mysq1dum? -udbroot -p[dbroot_password] supDB >
Note: Take a note of /var/TKLC/1sms/free/supDBdump.sql
EMS configuration (IP, Note: Below warning message can be ignored if displayed:
user, Group) and delete warning: Using a password on the command line intertace can
the same on LSMS. be insecure.
Edit supDBdump.sql to fix Authorization table
# sed -1 's/function/functions/g' supbDBdump.sql
9. LSMS Active server: Create MySQLUserGrants.sql file listing all the users and their privileges using
[ | Take MySQL dump of the following shell script MySQLUser.sh in the root directory:
mysql.user.

File: MySQLUser.sh
MYSQL_CONN="-udbroot -ppassword"

mysql ${MYSQL_CONN} --skip-column-names -A -e "SELECT
CONCAT( 'SHOW CREATE USER ''',user,'’'’'@'’'’',host,''';"') FROM
mysql.user WHERE user<>''" | mysql ${MYSQL_CONN} --skip-
column-names -A | sed 's/$/;/9' | sed "s/IDENTIFIED WITH
‘'mysql_native_password' AS/IDENTIFIED BY/q" | sed
"s/IDENTIFIED WITH 'mysql_native_password'/IDENTIFIED BY/g" |
sed "s/REQUIRE NONE PASSWORD EXPIRE DEFAULT ACCOUNT
UNLOCK//g" > /var/TKLC/Isms/free/MySQLUserGrants.sql

mysql ${MYSQL_CONN} --skip-column-names -A -e "SELECT
CONCAT( 'SHOW GRANTS FOR ''',user,''’'@''',host,"''';"') FROM
mysql.user WHERE user<>"''" | mysql ${MYSQL_CONN} --skip-
column-names -A | sed 's/$/;/q9' |sed 's/IDENTIFIED BY
PASSWORD/IDENTIFIED BY/g' >>
svar/TKLC/1sms/free/MySQLUSerGrants.sql

Note: Edit MYSQL_CONN for the proper connection properties and this will
generate the MySQLUserGrants.sqgl file with grant statements from the 5.7
machine that you can source into the 8.0 machine.

Run the MySQLUser.sh file to generate MySQLUserGrants.sql

# chmod +x MysQLUser.sh
# ./MysSQLUser.sh

Run command to edit MySQLUserGrants.sql
# sed -1 's/CREATE USER/CREATE USER IF NOT EXISTS/g'
MySQLUserGrants.sql

The content of the MySQLUserGrants.sql will be like:
GRANT USAGE ON *.* TO 'lsmsadm'@'%' IDENTIFIED BY
'570851ac3cc01499';

Edit the .sqgl file and replace the password of all the users with plain text password

to contain something like:
GRANT USAGE ON *.* TO 'Ismsadm'@'%' IDENTIFIED BY 'password-
in-plain-text’';

Run below commands to recover plain text password for default Isms users:
For dbroot user:
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{usr/TKLC/Isms/tools/pass_fetch passl

For materepl user:
fusr/TKLC/Isms/tools/pass_fetch pass3 -> materepl
For cmdline user:

/usr/TKLC/Isms/tools/pass_fetch pass4

For other default users:
{usr/TKLC/Isms/tools/pass_fetch pass2

Remove entry for “Ismsrepl’ @ <Ismsgs IP>" from the
MysSQLUserGrants.sql. This will be added during LSMSQS
configuration.

Note: There is no way to reverse the hash to recover the plain text. So the
customer has to provide us the plain text passwords for users which were added by
customer.

Edit the MySQLUserGrants.sq] file and edit the second line:

CREATE USER IF NOT EXISTS "dbnopriv'@'%' IDENTIFIED BY ;
Here ‘’ are missing before ;

10. | LSMS Active server: )
[7 | Log into the Active LSMS Login to LSMS GUI as Ismsall user.
server GUI
11. | LSMS Active server: ) ) )
[ | Record the configured Go to “Admin -> MySQL Port -> View” and record the configured MySQL Port.
MySQL Port
12. | LSMS Active server: G Confi LNP Svst EMS > V q it fiaured
. o to “Configure -> ystem -> -> View” and record the configure
L] | Record the configured | g ap Credentials

This procedure is complete!

Procedure 7 TRANSFER DATABASE TO REMOTE SERVER

Procedure 7 - Transfer Database to Remote Server

H UMW

This procedure transfers the database backup from the LSMS server to the remote server.

Estimated time: 30 minutes

Note: 100mbps link is required for database transfer to remote server.

—_

LSMS Active server:

Log in to the server as the
user “root”

Login: root
Password: <root_password>

L

LSMS Active server:

Verify Connectivity
between the LSMS and the
remote server.

# ping <remote IP> —c 3

PING <Remote IP> (<Remote IP>) 56(84) bytes of data.

64 bytes from <Remote IP>: icmp_seq=1 tt1=64 time=0.022 ms
64 bytes from <Remote IP>: icmp_seq=2 ttl1=64 time=0.020 ms
64 bytes from <Remote IP>: icmp_seq=3 ttl=64 time=0.020 ms
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If the remote server cannot
be pinged, verify the
network connectivity.

--- <Remote IP> ping statistics ---

3 packets transmitted, 3 received, 0% packet loss, time
2001ms

rtt min/avg/max/mdev = 0.020/0.020/0.022/0.005 ms

3. | LSMS Active server:
[] | List the snapshot files

1s -1rt /var/TKLC/1sms/free/*snapshot*
1s -1rt /var/TKLC/1sms/free/supDBdump.sql
1s -Trt /var/TKLC/1sms/free/MySQLUserGrants.sql

H W

4. Remote server:

] | Remove the existing DB
snapshot files

# rm /var/TKLC/1sms/free/mysql-snapshot-*
# rm /var/TKLC/1sms/free/supbBdump.sql
# rm /var/TKLC/1sms/free/MySQLUserGrants.sql

5. LSMS Active server:

] | Copy snapshot files to a
Remote Server.

Transfer all the NPAC region DB snapshot files, the MySQL dump of supDB and
the MySQL dump of mysgl.user

Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,

NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB
# scp —-p /var/TKLC/1sms/free/mysql-snapshot-<NPAC
region>. tar.gz root@<Remote IP>:<Remote IP Path>
Password: <root_password>

# scp —-p Svar/TKLC/1sms/free/supDBdump.sq] root@<Remote
IP>:<Remote IP Path>
Password: <root_password>

# scp -p /var/TKLC/1sms/free/MySQLUserGrants.sql
root@<Remote IP>:<Remote IP Path>
Password: <root_password>

or

# cd /var/TKLC/1sms/free/

# sftp <username>@<IP address of remote computer>
Connecting to <IP address of remote computer>...

The authenticity of host '<IP address of remote computer>'
can't be established.

DSA key fingerprint is
58:a5:7e:1b:ca:fd:1d:fa:99:f2:01:16:79:d8:b4:24.

Are you sure you want to continue connecting (yes/no)? yes
warning: Permanently added '<IP address of remote computer>
(DSA) to the 1ist of known hosts.

<username>@<IP address of remote computer>'s password:

sftp> cd <target directory>

sftp> put mysql-snapshot-<NPAC region>.tar.gz
Uploading mysql-snapshot-<NPAC region>.tar.gz
sftp> put supbDBdump.sql

Uploading supDBdump.sql

sftp> put MysSQLUserGrants.sql

Uploading MySQLUserGrants.sql

sftp> bye

Remote Server:

[] | Verify the snapshot files are
present on the remote
Server.

&

# Ts -Trt /var/TKLC/1sms/free/*snapshot®
# 1s -1rt /var/TKLC/1sms/free/supDBdump.sql
# 1s -1rt /var/TKLC/1sms/free/MySQLUserGrants.sql

This procedure is complete!
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Procedure 8 IPM MPS SERVER WITH 64 BIT TPD 8.6.X

Procedure 8 - IPM MPS Server with 64 bit TPD 8.6.x

Software Upgrade Procedure

MPS X:

Insert TPD 8.6.x
USB media into the
USB port

Reboot server
# reboot

MPS X:

Press ‘del’ key to
enter the BIOS.
Enter System Time
and System Date.

MPS X:

Select Boot 2 Hard
Disk Drives option

* Hard Disk Drives

MPS X:

Press ‘Enter’ key
and select USB as
the 1% Drive
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Procedure 8 - IPM MPS Server with 64 bit TPD 8.6.x

Boot|
A N N N A T N N N N S N N R A A T A T A RN N I N A A AN T AT N A TR AN I NN TN ELE S
* Hard Disk Drives * Specifies the boot =
T OREEERIAEAIAINTALELIAIAEAELAELLNL LI EARALESSSRASAELENTE 2 sequeme from the *
i * available devices. B
* 2nd Drive [HDD:P1-INTEL S5DSC] * x
* 3rd Drive [HDD:PO-INTEL SSDSC] * &
T * *
* * *
* * *
T * *
T * *
T * *
T * *
E R Select Scresn =
- oo Select Item &
= LA Change Option =
E * F1 General Help &
i * Fi0  Save and Exit &
il ¥ ESC Exit *
* * *
T * *
PR N I N N N N N N N N E N I N N R N PN N E N E N R AN SN I NIRRT ENENE AR

MPS X:

Verify that the 1%
Boot Device is set
to USB.

5. . Boot)
MPS X:
Press ‘Esc’ key and * Boot Settings * Zpecifies the ]
. t OEFEEEASASEATRASEATAIREFENASFESRASAASAEARAEAEARAE4E £ Foor Device *
seIeCt BOOt DEV|Ce * * Boot Sectings Configuration * Priority Sequence. T
Priority i : i
t * *
* * Hard Disk Drives E 3
T L4 L4
: = =
T T T
t £ £
RN X : X
T T T
z rz Selsct Screen =
- J 5 Select Item -
- * Enter Go to Sub Screen *
t t Fi General Help L]
E * Fi0 Save and Exit R
¥ * ESC Exit 3
: * *
i i i
TR TR ATEARATARATATATATATATATAIRAATEATATATARATATACATAIATRSRARARAIAIRIR LIRS

6.

ale]
TR A IR A AT AR A R N AT A AN AN A AN A AR AN AR A RO N AN R AR O A RN A AN AN AT RO A ONEARNEAAAAAT
* Boot Device Priority * Specifies the boot g
POREEEAEEEERETRITETEAFEAEARTAANGALAAEALRTIREFRAAINENT % goquence from the ]
E * available devices, &
T * £ ]
. * L device enclosed in ¥
£ * parenthesis has been *
E * disabled in the &
* * corresponding type g
t * meny. 2
T L L]
L * 4
i * ®
- EA Select Screen &
t L Select Item *
¥ * o Change Option ]
E *F1 General Help ]
E * F10 Save and Exit ]
E * ESC  Exit &
% * *
* * *

TRATRENAAAINE

TR IR PRI NI A NN I NI AR A AN IR A AR AN A AN IR AR OAINAAANEIAEART

MPS X:
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Press ‘Esc’ key and
select Exit - Save
Changes and Exit
option

d PCIPnP E

EraAEEREES FAREEEEEEEARIRAS

AEEERAEIEAEBRASIRAEES

Enter Go to Sub Screen
F1 General Help

Fl0 Save and Exit
ESC  Exit

* Exit Options * Exit system =setup *
OARATAATTRASTEAATRAAT XS TEARTTAATELNTT XA I TRASTRASTLH ¥ gfter gaving the *
E * changes. *
* Discard Changes and Exit * =
* Discard Changes * F10 key can be used *
- * for this operation. *
* Load Optimal Defaults % L
* Load Fail=afe Dafaults T L
* * *
* * *
* . *
= * +
- R Select Screen =
E ®oEe Jelect Item B
* . *
* + +
x * *
] ] "
= . *
' *

z
LA R e A e e A T e A T A T L e L

8. MPS X:

Select [OK] to save
the configuration
changes.

The server will
reboot and TPD
boot prompt will
appear.

Main Lk =) PCIPnP Boot. Security Chipset Exi
N N N T T TR P AN TN SR P AT AN TA TR ATTASRASRAIRIEY

* Exit Options * Exit system setup L
T ATENTENTASEALE T TATTANEESEN S T T TEXTENTRNENY & afte[ Swing thE T
K * changes, ]
* Digcard Changes and Exit * ¥
# Discard Changes * F10 Eey can he used '
T * for this operation. |
% Load Optlml i t thithstdsdds i i tthttdtdasaasaa e At ANty i
* Load Failsafe * H :
¥ * Save configuration changes and exit setup? ¥
t * # t
T LRSS AR AR AR AR iRt ittt iRt ittt iitidd T
& E [Cancel] z
T RN N RN PR RN RN RN RN PR NIRRT IR TN A T Scregn ]
T T
£ * Enter Go to Sub Screen *
. Ll General Help '
E * Fi0  Save and Exit :
* * ESC  Exit =
T * T
L * £

ttfitditdiddiddevredvevvevrewrevddddddddvddddddivvewvewvevvewvewvibddbddbdddadds

9. MPS X:

Start the IPM
process by entering
the TPDIvm
command at the
boot prompt.

ISOLINUX 6.04
boot: TPDL

Copyright (C) 1994-2015 H. Peter Anvin et al

10. Ololg | Mesx
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After a few seconds,
additional messages
will begin scrolling
by on the screen as
the Linux kernel
boots, and then the
drive formatting and
file system creation
steps will begin.

—onTIiguring SLorags
Creating disklabel on /dev/sdb

Creating mdmembesr on /Jdev/ =db2

Creating biosboot on Jdev/sdbl

Creating disklabel on /Jdewv/=sdc

© ating mdmember on Sdev/sdc2

ating lvmpwv on /dewv/md/1

Creating extd4d on Jdev/mapper/vgroot—plat wvar tklc
Creating extd4 on /dev/mapper/vgroot—plat_tmp
Creating extd4d on /Jdev/mapper/vgroot—-plat
Creating extd on /Sdev/mapper/vgroot—plat
Creating swap on /dev/mapper/vgroot—plat
Creating extd on /dev/mapper/vgroot—plat
Creating biosboot on /dev/sdcl

[

v
var

=wap
root

Running pre—installation scripts
Running pre—installation tasks
Installing.

Starting package installation process
Downloading packages

11. MPS X:

Once the drive
formatting and file
system creation
steps are complete,
the screen at right
will appear
indicating that the
package installation
has begin.

LlisLdiiing Cldlyg-—resource-1l11esysLell.xo0_ 04 (L1727 10u7)

Installing adwaita-cursor-theme.noarch (1176/1507)
Installing adwaita-icon-theme.ncarch (1177/1507)
Installing gtk3.x86 64 (1178/1507)

Installing gjs.x86¢ 64 (1179/1507)

Installing adobe-mappings-pdf.noarch (1180/1507)
Installing libgs.x86 &4 (1181/1507)

Installing graphviz.x86 64 (1182/1507)
Installing python3-pydot.noarch (1183/1507)
Installing python3-pygraphviz.xz86 64 (1184/1507)
Installing ghostscript.x86 &4 (1185/1507)
Installing cups.x86_64 (1186/1507)

Installing cups-filters.x86 64 (1187/1507)
Installing python3-networkz.noarch (1188/1507)
Installing gnome-characters.x86¢ 64 (1189/1507)
Installing libcanberra-gtk3.z86_64 (1190/1507)
Installing libgnomekbd.x86 64 (1191/1507)
Installing libtimezonemap.xz86_ 64 (1192/1507)
Installing firewalld.noarch (1193/1507)
Installing open-vm-tools.x86_64 (1194/1507)
Installing TPD-upgrade.noarch (1195/1507)
anstalling TKLCe5appb.noarch (1196/1507)

12 MPS X:

Once all the
packages have been
successfully
installed, the screen
at right will appear
letting you know the

installation process
Oygg is complete.

Remove USB
media before
Reboot.

MPOINT:
Media already mounted.
DEV: /dev/sda
MPOINT:
Media already mounted.
DEV: /dev/sda
MPOINT:
Media already mounted.
DEV: /dev/sda
MPOINT:
Pulling ISO Metadata file from: /run/install/repo//.isometadata
Copying ISO metadata file to system
DIR: /mnt/sysimage/var/TKLC/log/ipm
Copying ISO metadata file to prodinfo
DIR: /mnt/sysimage/usr/TKLC/plat/etc/prodinfo
Changing default target to application.target
Revoke root ssh access
Installation complete

Use of this product is subject to the license agreement found at:
/usr/share/oraclelinux-release/EULA

Installation complete. Press ENTER to quit: I
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On MPS server
press <ENTER> to
reboot the system
and continue with
the next step.

13.

MPS X:

Press ‘del’ key to
enter the BIOS

et

Chipset Exi

T Syscem Owverview * Use [ENTER], [TAE] L
T Ih et A it A e e N AN A A A A AN A v v v o v A vevavavavadaddads & oar [SHIFT_TAB] ]
* ANIBIOS * gelect a field. *
t Yergion :08.00.15 ¥ i
* Build Date:11/19/12 # Tze [4] or [-] to i
t Ip s DRCAADOS ¥ configure system Time. *
* * *
* Processor L r
t Intel(R) Xeon(R) CPU L5238 @ Z.66GHZ L |
¥ Speed 1Z26660Hz o q
¥ Count il E =
4 T g
* Syatem Hemory Ea Select Screen g
t 3ize ;819208 L Select Item g
] L Change Fisld 4]
t [rl=15:27] * Tah Select Field t
* Ayscem Date [Wed 04/20/2016] ¥ T General Help ¥
‘ * F10 Save and Exit =
t * ESC  Exit t
T T T

R A R A A R N A A N N R N A A R A R AN A A NN N N I A A A A ST AT NN NS T AT S A RS ES A EHE

14.

MPS X:

Select Boot - Hard
Disk Drives option

A T T T N I N N T e e NI N AT I NI IR EI RN RIS YR RISOANESY

* Boot Settings Specifies the
FOIAEETAARBSANNIAANISAARIANALIIAARIANNSAANRIANRLANNRELY ¢ Boot Device

* * Boot Seccings Configuration Priority sequence
i from avallahle
Hard Drives.

=+

¥ Boot Device Priority

= = = = = =

' Select Screen

LA Select Item
Enter Go to 3ub Screen
F1 General Help

F10 3Save and Exit
ESC Exit

=+

# = = o =
# # = =% # = o # @ @ # % # # H# o H o 4 o

*
+
*
+
*
*
*
* L]
*
*
*
*
*
+
*
*

*
A N N N N N R NN R AN AN R I AN RN P EANREANA AL NREANERY

15.

O

O

O

MPS X:
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Press ‘Enter’ key
and select HDD:PO
as the 1% Drive

1st Drive [HEDD:PC-INTEL S5D5C]

16. MPS X:

Press ‘Esc’ key and
select Boot Device

Priority
* Boot Device Priority
Oaja|f
17. MPS X:
Verify that the 1%
O1{ 0O | O | Boot Device is set
to HDD:PO.
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1st Boot Dewice [HDD: FO-INTEL S5DSC]

18. MPS X:

Press ‘Esc’ key and
select Exit = Save
Changes and Exit
option

Save Changes and Exit

19- MPS X:
Select [OK] to save
the configuration

(]| O | O | changes. The server
will reboot.

Full Upgrade for LSMS 14.0
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* Exit Options * Exit system setup

T IRTETATRTRTLS FEETETLTATERELES FTEXETXTXILTRTNTLTILENEY § gfrer gaving the

* * changes.

* Dizscard Changes and Exit *

* Discard Changes * F10 key can be uzed
- * for this opsration.
* Load Qp';lml D T N AN N AT NI NN TN TN INENENTNT

* Load Failsafe * H

N
N

L4

i

T

T

T

L

* Save configuration changes and exit setup? 7 R
N E 1
AR A AR AR AR R ARttt i Rttt tiitidd) T
' [ 0k [Cancel] ' '
TRERERT AR ARARARARARARR AR ARAR AR EARARRenenennniflor Soreen ]
*

*

T

*

.

.

£

Item

* Enter Go to Sub Screen
*F1 General Help

* F10 Save and Exic

* ESC Exit

*

L R R

*

L L L I LR ST TrER

When the message ""Upstart Job ntdMgr: started", is displayed, press the
Enter Key to get the Login prompt.

same as the ISO
used.

20. . ; Oracle Linux Server 8.7
MPS X: Log into : .
the server as the Kernel 4.18.0-477.27.0.1.e18 8.x86 64 on an x86_ 64
D D D user “root” localhost login: root
Password:
21. MPS X: # getPlatRev
Verify that the 8.6.0.x.0-110.y.0
0o g platform revision is

This procedure is complete!

Procedure9  PRE INSTALL CONFIGURATION

Procedure 9 — Pre-Install Configuration

?_ This procedure will perform the initial configuration required for LSMS installation.
E A g | Estimated time: 15 minutes
; Note: Below procedure needs to be executed on both MPS A and MPS B servers.
1. MPS X: Log in to Login: root
1 | O | the server as the user Password: <root_password>
$6r00t’9
2. Ol MPS X: Switch user | # su - platcfg
to platcfg.
Select “Server
Configuration” Menu
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4| Main Menu |7

Maintenance
Diagnostics

ver Configuration
Remote Consoles
Hetwork Configuration
Security
Exit

3. MPS X:

Select “Hostname” 4 Server Configuration Menu F
Menu

Hostname
Designation/Function
Configure Storage
Set Clock

Time Zone

Exit

4. MPS X: Change the | gelect Edit and press [ENTER
L1 | O | host name. press [ ]

1) Select “Edit” from
the options dialogue
box.

2) Set the hostname

Select OK and press [ENTER].

Full Upgrade for LSMS 14.0
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Note: While connected to the serial console, some console output might come
when the user is using the serial console to configure the LSMS. Those serial
output are harmless and can be ignored.
5 MPS X:
O Hostname Configuration
Verify that the
Hosthame is correct
then select and press
“Exit”.
. Current Hostnsme: SmSpr
Otherwise repeat the el e o mSpri
step above.
6. MPS X: Navigate to | Select Designation/Function and press [ENTER]
the Designation
Information screen.
4 Server Configuration Menu F
Set Clack
Time Zone
Exit
7.
0O | O MPS X:
1) Select “Edit”
from the options
dialogue box.
2) Set the
Designation as “1A”
on Server A and as
“1B” on Server B,
Function as “LSMS
and press “OK”.
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NOTE: ——— Edit Designation ————

Designation:

Designation and
Function:

Function should be
entered in
UPPERCASE.

> MPS X Designation Information
Verify that the
Designation and
Function is correct _ ) )
then select and press Designation:
U] | O “Exit”. Function:

Otherwise repeatthe | 1 Speions ———

step above.
9. O | ;| MPsx: Exit the Selecqt Exit andﬁpress [ENTER] fco return to the Main Menu.
platcfg menu Server Configuration Menu
NOTE: Hostname
DO NOT set the Designation/Function
time zone in platcfg. Configure Storage
Set Clock

The time zone will i
Time Zone

be set later in initial .
configurations.

Select Exit and press [ENTER]. The “platcfg” utility terminates.

Full Upgrade for LSMS 14.0
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——] Main Menu |——

Maintenance
Diagnostics

Server Configuration
Eemote Consoles
Hetwork Configuration

This procedure is complete!

Procedure 10 CONFIGURE NETWORK INTERFACE USING PLATCFG UTILITY

Procedure 10 — Configure Network Interfaces using platcfg utility

? This procedure configures the network interfaces and makes the ESAPPB servers accessible to the network.
E | B | Estimated time: 5 minutes
P
#
. console Login: root
L[ O] MPsX: Password: <root password>
Login as root
user.
> | O] mes x: # su - platcfg
Login to
platcfg utility
3.| OJ | MPS X: lgggggqu Main Menu tgggggggk
Confi } .
Nonlgﬂe £ Maintenance %
etwor £ Diagnostics a
Interface ¥ Server Configuration a x
¥ Remote Consoles a X
¥ Security b4
tlNetwork ConfigurationjEges
2 Exit %
4 X
nggaaggaaagaaaaaaaaaaaaaaad
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Software Upgrade Procedure

lu Network Configuration Menu tk

Routing

Configure Network
Network Bridges
CHRONY

Iptables

Resolw

IPSEC Configuration
Stunnel

Modify Hosts File
Exit

A T A A A A A
[T VO R R VT F T R T
T T T

i

ngggagagaagaaaaaaaagaaaaaaaaaaad

lu Network Interfaces Menu tk

X %
¥ Add an Interface X
eIl dit an Interface =
2 Delete an Interface a X
% Restart an Interface a x
% Exit %
X %
m{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T{T".I
1 Connection to edit Menu k

2 %

% bond0 %

% bond0.2 %

2 %

%z ethl X

%z eth?2 X

%z eth3 X

x Exit X

2

b

ueelelofelofelofevle(slo(e(ole(ofe e lo(s (e lo(e ]

————4 Options F—————
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4. | U

MPS X:

Select
Interface
Options

lgggggggqgqu Interface Options tggggggggk
vru:

GRO:

GS0:

hwaddr:
BootProto:

IPv6o Autoconf:

1ggggggqgk

3

Mqqgaqgaq

PR T LR L B B B T A
T T T T O O T T O T O O

MO O O O O T T O T O Y T O O R T O CT T O T T O Y T Y CY T O CT RO T O oy e
—l Configure Ethtool Options |—

Would you like to configure Ethtool Options?

I Configure IP Address |

Would vou like to configure IP addresses?

4 Choose IP Address Version Menu

IEvE
Exitc

Confidential - Oracle Restricted




Confidential - Oracle Restricted

Full Upgrade for LSMS 14.0

Procedure 10 — Configure Network Interfaces using platcfg utility

Software Upgrade Procedure

Choose Address Action:

———————1 Choose IPv4 Address Action f————————

default route.

Network Interfaces
Metwork Bridges
Configure Metwork
Routing

TP

Iptables

IPSEC Configuration
Rezsaolw

Stunnel

Modify Hosts File
Configure Switch
Exit

5.1 0| MPS X:
Input the IP Address:
Interface Hetmask:
Address Start on Boot:
Liwve:
I Me=ssage
Interface Edited
Pres=s any key to continume. . .
Select “Exit” until you exit from the platcfg utility.
6. [] MPS X: -4 Network Configuration Menu F
Cmﬁ@um SNMFP Configuration

Full Upgrade for LSMS 14.0
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1 Add default Route qqggggagk
®
b4 Device: < > bond0O %
b4 < > bond0.2 ¥
b4 <o> ethO ¥
bt < > ethl ®
b4 < > eth? %
b4 < > eth3 ¥
% Gateway: 10.250.50.1 )
bt ®
= [§4 Cancel )
3
mqqqqqqqqqqqqqqqqqqqqqqqqqqqjm
cc
Select “Exit” until you exit from the platcfg utility.

Procedure 11 INSTALL THE LSMS APPLICATION

Procedure 11 - Install the LSMS Application

This procedure installs the application on the server.
Estimated time: 25 minutes

Note : Below procedure needs to be executed on both MPS A and MPS B servers.

Rl om-on

MPS X: Log into
console the server as
the user “root”

Console Login: root
Password: <root_password>

MPS X: Perform
Procedure in 3.7A.1
or copy LSMS
14.0.X ISO to
Ivar/TKLC/upgrade
directory.

MPS X: Start
platcfg utility by
logging in as platcfg
user.

# su - platcfg

MPS X: Early
upgrade checks

The platcfg Main Menu appears.

On the “Main Menu”, select Maintenance and press [ENTER].

Full Upgrade for LSMS 14.0
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lggggggu Main Menu tgggggagk

Maintenance
Diagnostics
Server Configuration
Network Configuration
Remote Consoles
Security

Exit

R
AT T T ]
I A

meraaaaaaaaadaaaaaaaaaaaaaad

Select the “Upgrade” menu and press [ENTER].

lgggqu Maintenance Menu tgggqqgk

Dual Tmage Upgrade

w

e T

Upgrade

Patching
Backup and Restore

View Mail Queues

Restart Server

Save Platform Debug Logs
Platform Data Collector

Exit

POMOM PR M M oM M M X
Moo

ule(s(ofes(s(e(s(o(e(s(s(e(s (o (e s (o (e s (o (e s (o (e s (e (e e )y

Select the “Early Upgrade Checks” menu to verify that the system is ready for
upgrade.

lgggggagqu Upgrade Menu tgggqgggggk
X X
x Validate Media =
vl arly Upgrade Checks a =
x Initiate Upgrade =
% Copy USB Upgrade Image a x
x Non Tekelec RPM Management a x
% Accept Upgrade a
z Reject Upgrade a =
x Exit =
I ¥
uls(e(s(e(s(o(e(e(e(o(e(e(e(e(o(e(e(e(o(o(e (s (s(e(s e (e (o (e e o ]

Select the desired upgrade media and press [ENTER].

lgggaggaqgagdadaadgaqu Choose Upgrade Media Menu tggqgqaqgdqgdaadaddaddak

b4 |
pell.SMS—-14.0.0.0.0 140.6.5-x86 6d.is0 - 14.0.0.0.0 140.6.5 b4
% Exit |
e x|

mggg9q99999999999999999999999999999999999999999999999999999999IIIITIT ]

If the Early Upgrade Checks fail due to the ongoing syncing of raid mirrors, then
follow the steps 5 and 6 to ignore the disk mirroring before the LSMS installation. If
the Early Upgrade Checks passed then jump to Step 7.
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Early Checks failed for the next upgrade

Look at earlyChecks.log for more info

tarting Early Upgrade Checks at 1011413059

Punning earlyUpgradeChecks () for Upgrade::EarlyPolicy::TPDEarlyChecks upgrade policy...
Verified serwver is not pending accept of previous upgrade

ERROR: Raid mirrors are syncing!

ERROFR: mdi is syncing!

ERROR: earlyUpgradeChecks() code failed for Upgrade::EarlyPolicy::TPDEarlyChecks
ERROER: Failed runnhing earlyUpgradeChecksi() code

Hardware architectures match

Install products match.

No Application installed yet.. 3kip alarm check!

ERRCOR: Early Upgrade Checks Failed!

User has requested just to run early checks.

MNo upgrade will ke performed...

Early Upgrade Checks finished at 1011413059

[adwusrlepappri ~]§ cat fproc/mdstat

Personalities : [raidl]

mdl : active raidl sdbZ[1] sdaZ[0]
262080 blocks super 1.0 [2/2] [UU

md2 @ active raidl =sdal[0] sdbil[1]
4658447232 blocks super 1.1 [2/2] [UU]
[E====>.. . iiiieinn 1 resyne = 29.7% (139377920/465447232) finish=73.0wmin sSpeed=75060K/=se
bitmap: 4/4 pages [16KB], 65536KE chunk

unused devices: <nonex>

Contact My Oracle Support following the instructions on the Appendix E, if the early
upgrade checks fail due to any other reason.

5. MPS X: Exit the
O d platcfg menu

Select Exit and press [ENTER] to return to the Maintenance Menu.

1lgggqqgaqqaadagdgaqdau Choose Upgrade Media Menu tggdggqadqqadaddadqdadak

ES b4
x LSMS-14.0.0.0.0 140.6.5-x86 64.iso - 14.0.0.0.0 140.6.5 b4
EQlF ]t bd
Ke b4

Ingggggggagqagagqagagdgqaqaadagaqaagagaaaaagaaaqagagaqaaagaqadagqaqagagaqod]

lgggggggu Upgrade Menu tgggggggak

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USB Upgrade Image

Non Tekelec RPM Management
Accept Upgrade

Reject Upgrade

U E I P T T}

b4
b
bt
]
4
o
b4
b4
bt
]

W o MM W W M N

[mgogqgggggaqagqaaqaqaqaaaaaaqaqaddd

Select Exit and press [ENTER] to return to the Main Menu.
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lggggqu Maintenance Menu tggqqgk

Dual Image Upgrade
Upgrade

Patching

Backup and Restore

View Mail Queues

Restart Server

Save Platform Debug Logs
Platform Data Collector

AU VI P P T
T T

PR M W MM M M oW W

ngqg9q9q9qqIq9q9q9Iq9Iq9I9g9q9IqIqaIgadd

Select Exit and press [ENTER]. The “platcfg” utility terminates.

lggggggqu Main Menu tgggggggi
iz X
2 Maintenance %
2 Diagnostics a
2 Server Configuration a
2 Network Configuration a x
% Remote Consoles a X
2 Security b4
52 X
Iz b4
ile(e(efe(e(e(s(e(e(e(a(e(e(e(a(o(e(e(e(s{e(e (e (e (e (o]

6. MPS X: Ignore disk

0J | O | mirroring before # echo "IGNORE_EARLY_CHECKS=1" >
LSMS installation | /var/TKLC/Tog/upgrade/tmp_upgrade.conf

verify:
# cat /var/TKLC/log/upgrade/tmp_upgrade.conf
IGNORE_EARLY_CHECKS=1

7. olo MPS X: Validate On the platcfg “Main Menu”, select Maintenance and press [ENTER].
the upgrade media

lgggggaqu Main Menu tgggggggk
b pA

dMaintenance pr

Use the “Arrow” % Diagnostics =
and the [ENTER] % Server Configuration a =
: 2 Network Configuration a x

keyS to na_VIgate the = Remote Consoles a =
Menu options as % Security = =
shown to choose the | ¢ Exit x
b= |

upgrade media. -
Imagaaaaaaaaaaaaaaaaaaaaaaada
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lgggogqu Maintenance Menu tgggggk

Dual Image Upgrade

Backup and Restore a
View Mail Queues a
Restart Server a
Save Platform Debug Logs a
Platform Data Collector a
Exit

WOMOM oM M M oMM W W
I

ngqgqIIIIIIIIIIIIIIIIIIgIIggIggIqg]

lgggggggu Upgrade Menu tgggggaadak

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USB Upgrade Image

Non Tekelec RPM Management
Accept Upgrade

Reject Upgrade

Exit

A A A
[T T T
I

s e ElE s e e e e =

lggggggaqgaqgagaggaqu Choose Upgrade Media Menu tgqgqqaqdqaqdqqqqadaaadak

g9999999999999999999999999999999999999999I99IIIIIIIIIIIIIIIIIIIIITTT ]

The results of the validation will be displayed, similar to the
example below.

Press the “enter” key to continue.

Press any key to
return to the menu
and then press Exit
all way back to the
Maintenance Menu

Full Upgrade for LSMS 14.0
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33 s s R e s s s s s s s
FRefFEF R 4F AR AFHEERAAA SRR AR A SRR EAEA SR AR S S A A E LS
ettt dFEEEHAFFEEERAASEIERASAESRAAAAS SR AAAES RS A AL
[d3ss st sttt st s as st tsdiss sttt s
FReftEF LR 4F AR AFHEERAAF S ERAA RS EAEAS AR S SRS EEE LS
idass ittt sstassssditsiasdi sttt sttt tstisi
(i s s s Eas s it aas it ssa ittt sttt s s
FReftEF LR 4F AR AFHEERAAF S ERAA RS EAEAS AR S SRS EEE LS
iZ3ss s it sttt asiassissss ittt sttt
FRefFEF R 4F AR AF SRR AAA SRR AR A SRR A AR AR A LS
FReSEFEF LR EFEERREAFHEERAAASIERAA A SR AR ESS AR ES S EEEELS
iZ3ss s aass ittt asiassassss it sttt
FReftEF R 4F AR AF SRR AAA SRR AR A SRR EA A AR AR S A LS
FReSEFEF LR EFEERREAFHEERAAASIERAA A SR AR ESS AR ES S EEEELS
iZ3ss s aass ittt asiassassss it sttt
FRefFEF R 4F AR AFHEERAAA SRR AR A SRR EAEA SR AR S S A A E LS
ettt dFEEEHAFFEEERAASEIERASAESRAAAAS SR AAAES RS A AL
i3 s s st it aa it ss it ittt st dsd]
FReftEF LR 4F AR AFHEERAAF S ERAA RS EAEAS AR S SRS EEE LS
iZ3ss s it sttt asiassissss ittt sttt
(i s s s Eas s it aas it ssa ittt sttt s s
FRefFEF LR EF AR AFHEERAAA SRR AA RS AAEAS AR S SRS AEE LS
iZ3ss s it sttt asiassissss ittt sttt
FRefFEF R 4F AR AF SRR AAA SRR AR A SRR A AR AR A LS
FReSEFEF LR EFEERREAFHEERAAASIERAA A SR AR ESS AR ES S EEEELS
iZ3ss s aass ittt asiassassss it sttt
FReftEF R 4F AR AF SRR AAA SRR AR A SRR EA A AR AR S A LS
ettt tdt A SFEEERE

JMVT Validate Utility v2.3.4, (c)Tekelec, May 2014
Validating /var/TKLC/upgrade/LSMS-14.0.0.0.0 140.6.5-x86 64.iso
Date&Time: 2023-12-16 06:37:36

Volume ID: 14.0.0.0.0_140.6.5

Part Number: N/A

Version: 14.0.0.0.0_140.6.5

Disc Label: LSMS

Disc description: LSMS

The media validation is complete, the result is: PASS

CDROM is Valid

PRESS ANY KEY TO RETURN TO THE PLATCFG MENU.

8. MPS X: Navigate to
O] | OO | the initiate Upgrade
menu.

Use the “Arrow”
and the [ENTER]
keys to navigate the
Menu options as
shown to choose the
upgrade media.

Select the Initiate Upgrade menu and press [ENTER)].

lggggggqu Upgrade Menu tggggggggk

2 X
% Validate Media b4
% Early Upgrade Checks a x
bk@nitiate Up e b4
¥ Copy USB Upgrade Image a x
x Non Tekelec RPM Management a x
% Accept Upgrade a x
2 Reject Upgrade a x
®x Exit b4
Z X

uls(ofe(e(o(e(s(ofe(s(o(e(s(o(e(s(o(e s (o (e s (e (e s (o (e s (e e o)y

The screen displays a message that it is searching for upgrade media. When the
upgrade media is found, an Upgrade Media selection menu appears similar to the
example below.

Select the desired upgrade media and press [ENTER].
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lggggggaggggdadgaggadqu Choose Upgrade Media Menu tggggggq9qdgqd999999999k
= %
lll.SMS—14.0.0.0.0 140.6.5- 6d.iso - 14.0.0.0.0 140.6.5 |
X Exit X
b4 X

q99999999999999999999999999 9999999999999 IIIIIIIIIIIIIIIIIIIIITIIATT ]

O MPS X:
Upgrade proceeds

The screen displays the output like following, indicating that the upgrade software is
first running the upgrade checks, and then proceeding with the upgrade.

Mo Application installed yet.. Skip alarm check!
Verified all raid mirrors are synced.

Early Upgrade Checks Have Passed!

Early Upgrade Checks finished at 1447429031
Enitializing upgrade information...

Many informational messages appear on the terminal screen as the upgrade proceeds.
The messages are not shown here for clarity sake. When installation is complete, the
server reboots.

10.

u MPS X: Upgrade
completed

After the final reboot, the screen displays the login prompt as in the example below.

1462266947 Upstart Job TKL Csnmp-subagent: started
B e e e

1462266947 Upstart Job syscheck: started

EY Py IF PRy PN PE R Ny FE P A0 FY YT dy EY PRy Id§T
i L I A A e b R

1462266947 Upstart Job tpdProvd: started
BEHHATHHERR AR AR

1462266949: Upstart Job ntdMgr: started

EY PP ) IF PRy PN PE R Ny FE P A) FY YT dy EY PRy Id§T
i L I A A e b R

Oracle Linux Server release 6.7
Kernel 2.6.32-573.18.1.el6prerel7.0.3.0.0_86.44.0.x86 64 on an X86_64

lsmspri login:

11.

[ MPS X:
Login as root user.

Login: root
Password: <root_password>

12.

MPS X :

Check the upgrade
and warnings

# grep -i error /var/TKLC/log/upgrade/upgrade.log

1724760824: :ERROR: Command returned non-zero exit code 256
(systemct1 start TKLCpldhcp)

# grep -i error /var/TKLC/log/upgrade/ugwrap.log

# grep -i warning /var/TKLC/Tlog/upgrade/upgrade.log
1724760624 : :WARNING: TKLClsms-Config-2.0.4-14.0.0.1.0_140.9.0:
current hostname "Ssteak-B" being reset to default.

1724760681: : TKLC1sms warning: user %{root}
does not exist - using root

1724760681: :warning: group %{root} does not exist - using root
1724760759: :WARNING: Could not dup STDERR to STDOUT: Bad file
descriptor

1724760971: :WARNING: A new file was added to xml alarm
files...reparsing xml...

1724760971: :WARNING: FILE:
/usr/TKLC/plat/etc/alarms/1smsAlarms.xml

#

grep Up?rade returned success"
/var'/TKLC/ og/upgrade/upgrade.log
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1248284646:: Upgrade returned success!

# grep -i error /var/TKLC/log/upgrade/upgrade.log

only below error is expected

1512594958: : ERROR: Command returned non-zero exit code 768
(/sbin/service TKLCpldhcp start)

# grep -i error /var/TKLC/log/upgrade/ugwrap.log
There should be no error output.

# grep -i warning /var/TKLC/log/upgrade/upgrade.log
The following warning are expected:

The following warning are expected:

1512594173: :WARNING: /usr/TKLC/plat/etc/alarms/alarms.xml has
been updated...reparsing xml...

1512594265: :warning: erase unlink of /etc/ssm/hwmgmtd.conf
failed: No such file or directory
1512594267: :kexec-tools #warning:

/etc/kdump.conf created as /etc/kdump.conf.rpmnew

1512594414 : :setup
HRBHHHARRHHHARRHHHARRRHHAAR R R AR R R AR H AR ##Warning
/etc/shadow created as /etc/shadow.rpmnew

1512594430: :ca-certificates #H### AR # A warning :
/etc/pki/tls/certs/ca-bundle.crt created as
/etc/pki/tls/certs/ca-bundle.crt.rpmnew

1512594464: :warning: user mysql does not exist - using root
1512594464 : :warning: group mysql does not exist - using root
1512594464: :warning: user mysql does not exist - using root
1512594464: :warning: group mysql does not exist - using root

1512594464::2017-12-06 16:07:44 0 [warning] TIMESTAMP with
implicit DEFAULT value is deprecated. Please use --
explicit_defaults_for_timestamp server option (see documentation
for more details).

1512594465::2017-12-06 16:07:44 14331 [warning] InnoDB: New log
files created, LSN=45781

1512594465::2017-12-06 16:07:44 14331 [warning] InnoDB: Creating
foreign key constraint system tables.

1512594467::2017-12-06 16:07:46 0 [warning] TIMESTAMP with
implicit DEFAULT value is deprecated. Please use --
explicit_defaults_for_timestamp server option (see documentation
for more details).

1512594468: :WARNING: Default config file /etc/my.cnf exists on

the system

1512594469: :samhain warning: /etc/samhainrc
created as /etc/samhainrc.rpmnew

1512594473 : : php-common #warning: /etc/php.ini
created as /etc/php.ini.rpmnew

1512594551: :initscripts ##warning:
/etc/sysctl.conf created as /etc/sysctl.conf.rpmnew

1512594603: :ntp warning: /etc/ntp.conf
created as /etc/ntp.conf.rpmnew

1512594615: : TKLCplat #H#### R fwarning

/usr/TKLC/plat/etc/pid_conf created as
/usr/TKLC/plat/etc/pid_conf.rpmnew
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1512594615: :#warning: /usr/TKLC/pTlat/etc/service_conf created as
/usr/TKLC/plat/etc/service_conf.rpmnew

1512594630: : TKLCalarms ###warning:
/usr/TKLC/plat/etc/alarms/alarms.xm]l saved as
/usr/TKLC/plat/etc/alarms/alarms.xml.rpmsave

1512594637::alarmmgr ###warning:
/usr/TKLC/plat/etc/alarmMgr/alarmMgr.conf created as
/usr/TKLC/plat/etc/alarmmgr/alarmMgr. conf. rpmnew

1512594770: :WARNING: This capability is not defined in the
default capabilities.

1512594770: :WARNING: Nor is it defined in the current hardware
ID's capabilities.

1512594770: :WARNING: CAPABILITY: service__disabled
1512594770: :WARNING: HARDWARE ID: ESAPPB

1512594885: : sudo warning: /etc/sudoers
created as /etc/sudoers.rpmnew

1512594922 : :WARNING: TKLCIsms-Config-1.4.9-13.2.1.0.0_132.22.0:
Current hostname "Tsmspri" being reset to default.

1512594923 : :WARNING: Hostname not changed because it is the
same.

1512594966: :WARNING: Could not write to config file /usr/my-
new.cnf: Permission denied

1512594966: :Installing MySQL system tables...2017-12-06 16:16:06
0 [warning] 'THREAD_CONCURRENCY' 1is deprecated and will be
removed in a future release.

1512594966::2017-12-06 16:16:06 31217 [warning] The option
innodb (skip-innodb) is deprecated and will be removed in a
future release

1512594966::Filling help tables...2017-12-06 16:16:06 0
[warning] 'THREAD_CONCURRENCY' is deprecated and will be removed
in a future release.

1512594966::2017-12-06 16:16:06 31220 [warning] The option
innodb (skip-innodb) is deprecated and will be removed in a
future release

1512594966: :WARNING: Could not copy config file template
/usr/share/mysql/my-default.cnf to

1512594966: :WARNING: Default config file /etc/my.cnf exists on
the system

1512594972: :WARNING: A new file was added to xml alarm
files...reparsing xml...

1512594972 : :WARNING: FILE:
/usr/TKLC/plat/etc/alarms/TsmsAlarms.xml

1512594974 : :WARNING: Module variable EXPECTED_CPUS is
deprecated!

1512594975 :WARNING: CONFIG:
/usr/TKLC/plat/1ib/Syscheck/modules/system/cpu/config

1512594975: :WARNING: Module variable EXPECTED_CPU_ALM is
deprecated!

1512594975 :WARNING: CONFIG:
/usr/TKLC/plat/1ib/Syscheck/modules/system/cpu/config

1702719042 : :WARNING: TKLCIsms-Config-2.0.3-0.70555: Current
hostname "lsmspri" being reset to default.
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1702719098: : TKLCTsms
#HH T ###warning: user %{root} does not
exist - using root

1702719104: :warning: group %{root} does not exist - using root

1702719175: :WARNING: Could not dup STDERR to STDOUT: Bad file
descriptor

1702719391: :WARNING: A new file was added to xml alarm
files...reparsing xml...

1702719391 : :WARNING: FILE:
/usr/TKLC/plat/etc/alarms/1smsAlarms.xml

13. MPS X: # rpm -qi TKLClsms

Verify LSMS
release.

This procedure is complete!

3.6Initial Configuration

Procedure 12 LSMS INITIAL CONFIGURATION

Procedure 12 - LSMS Initial Configuration

S | This procedure does the initial configuration on the LSMS servers.

E Estimated time: 15 minutes

P

# T

1. | MPS A: Log in to the server asthe | Login: root

Ol user “root” Password: <root_password>
2. | MPS A: # su - Tsmsmgr

0] start Ismsmgr utility by logging in as
Ismsmgr user

3. | MPS A:

Select “Initial Configuration”
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——] Main Menu ——

Maintenance
Diagnostics

Server Configuration
Network Configuration
Exit

4 | MPS A:

Select “yes”

Select OK and press [ENTER]

—] Select running options |

5. | MPS A:

Enter password for “root”

Select OK and press [ENTER]

- Query for FirstTimeConfig::010EKeyExchange |

Enter root password: _

6. [ MPS A:

Enter password for “Ismsadm”

Select OK and press [ENTER]

- feery for FirstTimeConfig::0IlZAdmFeyExchange |5

Enter lsmsadm password: _

MPS A:

I:l.\1

Enter password for “admusr”

Select OK and press [ENTER]

—| Query for FirstTimeConfig: :013RocotAdmUsrEKevExchange |—

Enter admusr password: _
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8.

O

MPS A:

Enter the NAS password used to
login into NAS console. Accept the
default serial port (ttyS2) when
prompted for the path to the NAS
console device.

Select OK and press [ENTER]

——————————— Query for FirstTimeConfig::05BackupConfig ————

Enter the NHAS root password for NAS configuration:: _
Enter path to HAS console device:: ;52

A message is displayed indicating the root Key Exchange was successful.

A message is displayed indicating the Ismsadm Key Exchange was successful.

A message is displayed indicating the admusr Key Exchange was successful.

A message is displayed indicating the Time Synchronization was successful.

A message is displayed indicating the Database creation was successful.

A message is displayed indicating the NAS Backup Configuration was successful.

A message is displayed indicating the inhibiting of the node was successful.

Select Exit and press [ENTER] repeatedly to exit Ismsmgr

MPS A:
Switch to mate

#ssh mate

MPS B:

Start Ismsmgr

# su - Tsmsmgr

MPS B:

Select “Initial Configuration”

——] Main Menu ——

Maintenance
Diagnostics

Server Configuration
Hetwork Configuration
Exit

MPS B:

Select “yes”

Select OK and press [ENTER]

—] Select running options |——

MPS B:

Enter the NAS password used to
login into NAS console.

Juery for FirsclimelConfig:DSBachOpLOnRTig

Enter the HAS root password for HAS configuracicn:: |GG

=1
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Select OK and press [ENTER]

15.1 A message is displayed indicating the Database creation was successful.
A message is displayed indicating the NAS Backup Configuration was successful.

Select Exit and press [ENTER] repeatedly to exit Ismsmgr

16.| MPS B: # minicom mate

O Log into the LSMS B server via
minicom.

17.1 MPS A: #init 6
C| Perform init 6 to reboot the LSMS B
card. Watch for errors during boot process.

When the login prompt is displayed, exit from minicom.

18.| MPS A: # minicom mate
O Log into the LSMS A server via

minicom.
19.| MPS B: # init 6

C| Perform init 6 to reboot the LSMS A | Watch for errors during boot process.
card. When the login prompt is displayed, exit from minicom.

This procedure is complete!

Procedure 13CONFIGURE TIME ZONE AND CLOCK

Procedure 13 — Configure Time Zone and Clock.

? This procedure configures the time zone and clock.
g | Estimated time: 5 minutes
z Note: Below procedure needs to be executed on both MPS A and B servers.
L | MPS X: Log in to the | Login: root
[ | server as the user Password: <root_password>
“root”.
MPS X: Start # su - lsmsmgr
2. Ismsmgr utility by
[ logging in as

Ismsmgr user.

MPS X:: Verify time | Select Server Configuration and press [ENTER].
zone.
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—— Main Menu [——

Initial Configuration

Maintenance
Diagnostics

Server Configuration
HNetwork Configuration
Exit

Select Time Zone and press [ENTER].
- Server Configuration Menmu |

Set Clock

Time Zone

Exit

The screen shows the current time zone setting.

cle ar r its affili: :. Al tggaggk #
.4

uisfeiele(s(s{efe(s(s (s efe s (s (e]e e s (o m]

If this is not correct, select Edit and press [ENTER].

If the time zone is correct, select Exit, press [ENTER] and skip the next step

L1 | zone.

4. MPS X: Change time

Select appropriate time zone and press [ENTER].

Confidential - Oracle Restricted




Confidential - Oracle Restricted

Full Upgrade for LSMS 14.0 Software Upgrade Procedure

Procedure 13 — Configure Time Zone and Clock.

lggggggu Select Time Zone Menu tggggggk

hmerica/Mazatlan
hmerica/Mendoza
hmerica/Menominee
bmerica/Merida
hmerica/Metlakatla
merica/Mexico City
America/Migquelon
America/Moncton
America/Monterrey
America/Montevideo
America/Montreal
America/Montserrat
bmerica/Nassau

oo

ca/New York
America/Nipigon
bmerica/Nome
hmerica/Noronha

[ I U T U T
A A A A R

L T T

il {o (o o o {o (o (o o o (o o o (o (o o o o o o o (o o o o (o o o o o o o (o o e o

Select Yes to set the hardware clock to GMT and press [ENTER].
lggogoggagagou Time Zone tggggagqaggagk

= =
® Set hardware clock to GMT? b4
= =
= Lagggagkil]l gaog k.4
4 xlﬁﬂﬂlx x Ho = [
= ogagg] magog] Qe
= =
= =

i1l fu fu o (o (o fw g g (o Lo o s f o o o o o o s o o [ (o e o o i s

MPS X: Set clock. Select Set Clock and press [ENTER].
Server Configuration Menu

Set Clock

Time Zone
Exit

Select Edit and press [ENTER].
Oprtions
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Enter correct time.
—] Change Date and Time |—

'

Date:
Time:

Use right arrow to get to OK and press [ENTER].

6. MPS X: Exit the Select Exit and press [ENTER] to return to the Main Menu.

Bmsmgrnwnu Server Configuration Menu F

Set Clock
Time Zone

Select Exit and press [ENTER]. The “Ismsmgr” utility terminates.
Main Menu

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 14 SINGLE SUBNET CONFIGURATION FOR LSMS MPS CARDS

Procedure 14 - Single Subnet Configuration for LSMS MPS Cards.

This procedure configures the system as single subnet at the customer site.
Estimated time: 10 minutes

NOTE: All the information should be taken before starting upgrade as part of Section 1.6

HOmM4d®»

MPS A: Log into the | Login: root
server as the user Password: <root_password>

“root™.

I:lf—‘
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MPS A: Start # su - lsmsmgr
2. Ismsmgr utility as
[ Ismsmgr user.

MPS A: Change the | Select Network Configuration and press [ENTER].
3|':| network configuration

Maintenance
Diagnostics

Server Configuration
[Hetwork Configuratio
Exit

—{ Main Menu |——

Initial Configuration

Select Network Reconfiguration and press [ENTER].

-| Network Configuration

Network Reconfigurati
SHMP Configuration
Routing

NTIP

IPSEC Configuration
Modify Hosts File
Exit

Menu

Select Yes to proceed to Network configuration.
lggggggagagagaggggggu Network Reconfiguration tggggdgdgdgqoagagaadgk

-4

EE I

WLENING: Thi= action i=s service impacting. Are you sure?

L -

muqqqqqqaaaaaaaqqqqqqqqaqqaaauuuaqqngaaaauuuaqqaaaaaaaqqqqaqaaaaaaﬁ
A lynx driven screen will appear with the following prompt;

Do you want to execute "/usr/TKLC/Isms/tools/IsmsnetAdm-bin/Ismsnetadm.cgi"?

Type “Y/y” to continue and the next screen will appear and press the right arrow key to

follow the link

Select Single from the Subnet Type menu and then select Continue.

Full Upgrade for LSMS 14.0

Confidential - Oracle Restricted

14.0

63 of 100




Confidential - Oracle Restricted

Software Upgrade Procedure

Full Upgrade for LSMS 14.0

Procedure 14 - Single Subnet Configuration for LSMS MPS Cards.

Continne

MPS A: Enter
network values.

Using the up and down arrows, scroll through the text fields, entering the desired values ( to
enter the netmask, highlight the field and then use the enter key or right arrow key to
display the dropdown menu, choose the desired value from the list) for each fields:

Humber: LE1632ABSS

IF: 192.168.59.30 Netmask: [255.255.255.0 ]

IF: 192.168.59.31

Hetmask: [255.255.255.0 ]

' 192.168.59.32

-168.59.250

-10

Start Over

Once the values are entered press the down arrow to select the “Submit” button and press
the right arrow to follow the link.

Note: The System Number shall be as follows:
o LEYYWWMMXX
o  Where:
o LE is the new System Number Prefix for LSMS.
oYY = YEAR - year of the system shipment
o WW= WEEK - calendar week of the Y'Y year when the system is
shipped
o MM = MANUFACTURER (if other than TKLC) — Here 00 as
Manufacturer is Oracle
o XX =number in line of systems shipped that week
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MPS A: Apply
network settings

If the values pass a sanity test for validity, then the “Confirm” button will be visible. Use
the down arrow to select “Confirm” and press the right arrow to apply the changes. If the
sanity tests failed, the reasons will be stated. Use the left arrow key to go back to the edit
screen.

Confirm

The execution could take a few minutes, be patient. The screen will eventually report the
status of the completion. If an error occurs, contact My Oracle Support following the
instructions on the Appendix E.

Type “q” and then “y” to exit the Network Configuration.

Aedmin

LE11111111

ose utiltity (pre
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MPS A: Exit the Select Exit and press [ENTER] to return to the Main Menu.

> | Ismsmgr menu - Network Configuration Menu |

[l

Hetwork Reconfiguration
SHMP Comfiguration
Routing

HTP

IPSEC Configuration

Select Exit and press [ENTERY]. The “platcfg” utility terminates.
Main Menu

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Network Configuration

This procedure is complete!

Procedure 15 SEGMENTED CONFIGURATION FOR LSMS CARDS

Procedure 15 - Segmented Configuration for MPS LSMS Cards

$ This procedure configures the system as segmented subnet at the customer site.
g | Estimated time: 10 minutes
; NOTE: All the information should be taken before starting upgrade as part of Section 1.6
1. | MPS A: Log in to the server| Log1n: root
O as the user “root”. Password: <root_password>
2. | MPS A: Start Ismsmgr # su - Ismsmgr
] utility by login as Ismsmgr
user
3. | MPS A: Change the Select Network Configuration and press [ENTER].
[ network configuration
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——] Main Menu [—

Initial Configuration

Maintenance E
Diagnostics =
Server Configuration

Metwork Configuration E

Exit

Select Network Reconfiguration and press [ENTER].

- Hetwork Configuration Menu |

Hetwork Reconfiguration

SHMP Configuration
Routing

HTE

IPSEC Configuration
Modify Hosts File
Exit

Select Yes to proceed to Network configuration.

lgggggaaaaggaaaagggau Network Reconfiguration tgggggoaooaaaaaaadd
x

WABRNING: This action is service impacting. Are you sure?

ok

1. qqqqq]ﬂ,

magqqq]

1 agoqod
x HNo x
uile (s (s (e i

MoM oMM MMM

mﬂﬂGGGUqUUGGGGGGGGFUUUUGGqﬂgﬂﬂGGUUUUGgGGGGGGGGUUUGGGGGGGGGGUUUUGC
A lynx driven screen will appear with the following prompt;

Do you want to execute "//usr/TKLC/Isms/tools/IsmsnetAdm-
bin/lsmsnetadm.cgi"?

Type “Y/y” to continue and the next screen will appear and press the right arrow
key to follow the link

Select Segmented from the Subnet Type menu and then select Continue.

Continue

4. | MPS A:
[ Enter network values.

Using the up and down arrows, scroll through the text fields, entering the desired
values ( to enter the netmask, highlight the field and then use the enter key or right

L

Mo

oo
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arrow key to display the dropdown menu, choose the desired value from the list)
for each fields:

r: LE11111111

yv: 192.168.60.250
> IP: 192.168.60.3

v NPAC TP: 192.168.60.

Network

1 192.168

LAPP IP: 192.168.59.3 Netm : [255.255.255.0 ]

v APP IP: 192.168.59.4 Hetmask: [255.255.255.0 ]

* VIP: 192.168.59.5

Network
VLAN ID:
’r 192.168.61.38 2 1 [255.255.255.0 ]

IF: 192.168.61.51 Netmask: [255.255.255.0__

e TP: 192.168.59.250

: 10.250.32_.10

Start Over

Note: The System Number shall be as follows:

e LEYYWWMMXX
e  Where:
o LE is the new System Number Prefix for LSMS
oYY = YEAR - year of the system shipment
o WW=WEEK - calendar week of the Y'Y year when the system
is shipped
o MM = MANUFACTURER (if other than TKLC) — Here 00 as
Manufacturer is Oracle
o XX =number in line of systems shipped that week

*Default route should be the route of the APP IP address.
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Once the values are entered press the down arrow to select the “Submit” button
and press the right arrow to follow the link.

MPS A: Apply network
settings
O ™

b

If the values pass a sanity test for validity, then the “Confirm” button will be
visible. Use the down arrow to select “Confirm” and press the right arrow to apply
the changes. If the sanity tests failed, the reasons will be stated. Use the left arrow
key to go back to the edit screen.

Start Over

The execution could take a few minutes, be patient. The screen will eventually
report the status of the completion. If an error occurs, contact My Oracle Support
following the instructions on the Appendix E.

Type “q” and then “y” to exit the Network Configuration.
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Procedure 15 - Segmented Configuration for MPS LSMS Cards

2 Net Admin

NUM LE11111111
E single

pri

to go b

NOTE: If below error is observed after network configuration, run “systemctl
restart network” command after exiting from Ismsmgr menu.

# systemctl restart network

o

MPS A: Exit the Ismsmgr | select Exit and press [ENTER] to return to the Main Menu.
[ menu - Network Configuration Menu

Network Reconfiguration
SHMP Comfiguration
Routing

NTPE

IPSEC Configuration
Modify Ho=sts File

Select Exit and press [ENTER]. The “platcfg” utility terminates.
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4| Main Menu Ii

Initial Configuration
Maintenance
Diagno=stics

Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 16 TMN TOOLKIT AND MARBEN OSI LICENSE INSTALLATION

Note: Valid licenses need to be installed on both A and B LSMS servers. Refer to LSMS 14.0 Release Notes,
section 3.3: Marben OSI and TMN Toolkit license key files, for details. Be sure to start the process at least 7 days
before the scheduled upgrade date. If needed, temporary TMN Toolkit and Marben OSI licenses are available on
the Oracle Software Delivery Cloud (edelivery.oracle.com) with the LSMS software.

Procedure 16 - TMN Toolkit and Marben OSI License Installation

? This procedure will install the TMN Toolkit and Marben OSI License to both A and B LSMS servers.
E
P Estimated time: 5 minutes
#
L. MPS X: Logintothe | Login: root
server as the user “root” Password: <root_password>
L) O
2. MPS X: Install the Copy the TMN Toolkit license file to /usr/local/netech/etc/license path following any steps
TMN toolkit license file| mentioned in 3.7C.1 or 3.7C.2
L O
Open the file ‘/usr/local/netech/etc/license’ using vi or vim and copy the content of
license in the file and save the file.
Cross check the content of file using :
# cat /usr/local/netech/etc/license
3. MPS X: Install the
D D Marben OSI License Copy Marben OSI License string using below command:
file # echo "<Marben 0SI license string>" > /usr/TKLC/osi/conf/license
4. MPS X: Restart the Reboot the system to take effect
system
0o # reboot
This procedure is complete!
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Procedure 17 - Start LSMS services
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] - This will make node — Main Menu

active and start

application Initial Configuration

Maintenance

Diagno=stics

Server Configuration
Hetwork Configuration
Exit

Select Start Node and press [ENTER].
—4 HMaintenance Menu

LSM5 Node Status

Start Node

Stop Node

Inhibhit NHode
Backup and Restore
Exit

Select Yes to confirm node startup press [Enter]

? This procedure starts the LSMS services.
E Estimated time: 10 minutes
P
#
1. MPS A: Log in to the | Login: 5901: q
B server as the user Password: <root_password>
“root”.
) MPS A : Check Run below command to check Tsms status is UNINITIALIZED
’ hastatus "INHIBITED" before running startNode
[
# hastatus
UNINITIALIZED
if status is UNINITIALIZED and not UNINITIALIZED "INHIBITED" run
hafailover else continue with Step 3.
# lusr/TKLC/plat/sbin/hafailover --inhibit
# hastatus
UNINITIALIZED "INHIBITED"
3 MPS A: # su - lsmsmgr
0 Start Ismsmgr
4. MPS A: Start Node | On the “Main Menu”, select Maintenance and press [ENTER].
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Procedure 17 - Start LSMS services

4' Start Hode Ii

Confirm Node Startup

Select Exit and press [Enter] to return to Main Menu.
—| Maintenance Menu |—

LSMS NHNode Status
Start Hode

Stop Hode

Inhibit Hode
Backup and Restore

Select Exit and press [Enter] to exit the Ismsmgr menu.
—| Main Menu

Initial Configuration
Maintenance
Diagno=stics

Server Configuration
Hetwork Configuration

5 MPS A: #ssh mate
' Switch to mate
]
6 MPS B: Log in to the | Login: root
: server as the user Password: <root_password>
D €6r00t9’.
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. MPS B:

Start Ismsmgr

# su - Tsmsmgr

o

MPS B: Start Node

- This will make node
standby and start
application

On the “Main Menu”, select Maintenance and press [ENTER].

Main Menu

Initial Configuration

Maintenance
Diagnostics
Server Configuration
Hetwork Configuration
Exit

Select Start Node and press [ENTER].

—4 Maintenance Menu

LSM5 Node Status
Start Hode

Lol L L

Stop Node

Inhibit Hode
Backup and Restore
Exit

Select Yes to confirm node startup press [Enter]

Confirm Node Startup

4' Start HNode Ii

Press Enter once the node is uninhibited successfully.
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Select Exit and press [Enter] to return to Main Menu.

—| Maintenance Menu |—

L5HM5 Node S5tatus
Start Node

Stop Hode

Inhibit Hode
Backup and Restore

Select Exit and press [Enter] to exit the Ismsmgr menu.
—| Main Menu

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 18 POST CONFIGURATION HEALTH CHECK

Procedure 18 — Post Configuration Health Check

This procedure determines the health of the Server after an installation. This procedure will perform a
syscheck on each LSMS server.

*F O Mm--Hw

Estimated time:5 minutes

Full Upgrade for LSMS 14.0
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Procedure 18 — Post Configuration Health Check

] Login: root
.| MPSAandB:Log | password: <root_passwords
[ | into the server as the
user “root”.
. # date
2. | MPS Aand B: Thu May 12 05:55:27 EDT 2016
[]| Validate date, time and
time zone to ensure
accuracy.
MPS A and B: Execute the following command on both LSMS A and B to verify the HA state of mated
Execute the “hastatus” | LSMS pair.
command to verify the # hastat
HA state of this server. astatus
Verify that the hastatus of one of the servers is Active and the other is Standby.
WARNING: If the output from the above command is anything else other than
“ACTIVE” and “STANDBY”, do not proceed with this procedure and contact My
Oracle Support following the instructions on the Appendix E.
3. | LSMS Standby server: | Execute the following command to verify that MySQL replication is working correctly
1| Verify that the on the STANDBY LSMS server:
STANDBY server’s | # tail /var/TKLC/1sms/logs/dbrepiMon.Tog
MySQL replication is | £ MySQL replication is functioning correctly then the following output will be
functioning properly. | gpserved, make sure that at least the last line of your output matches the lines below.
Thu May 12 05:58:12 2016 All tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 05:59:19 2016 A1l tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 06:00:25 2016 Al1l tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 06:01:32 2016 A1l tests passed on STANDBY
WARNING: If at least the last line of your output does not match the lines above then
do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.
4. | MPS A and B: # syscheck
1| Execute syscheck Running modules in class disk...
0OK
Running modules in class hardware...
0OK
Running modules in class Ismshc...
0K
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Running modules

Running modules

Running modules

Running modules

Running modules

in

in

in

in

in

class

class

class

class

class

net...

OK
proc...

OK

services...

OK
system. ..

OK
upgrade. ..

OK

e LOG LOCATION: /var/TKLC/Tog/syscheck/fail_log

b

1| Capture the output of

Services if required.

LSMS Active server: Execute the following command on the ACTIVE LSMS server to display the current
LSMS sentry status:

‘sentry status’ # sentry status

command NOTE: Verify that the output displays a Status of “running” for all processes; the
regional processes (npacagents) may or may not be associated in the Comment field. If
the output from this command displays any other Status than “running” contact My
Oracle Support following the instructions on the Appendix E.

Capture the output from this command and make it available to Oracle Technical

This procedure is complete!

3.7Data Migration

Procedure 19RESTORE DATABASE

Procedure 19 - Restore Database

? This procedure restores the database on the LSMS server.
E | Estimated time:60 minutes
P
#
. Login: root
1. | MPS Aserver: Password: <root_password>
] | Log in to the server as the
user “root”.
2> | MPS A server: Uagsfirgll thefNPA(Ii reg;ion DB snapshot files, supDB MySQL dump and users
[T | Copy the snapshot files ySQL dump from the Remote server to current LSMS A server.
from the Remote server to
the current LSMS Active Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,
server. NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB
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# SCp —p r',oot@<Remote IP>: <Remote IP Path>/mysq/-snapshot-
<NPAC region>.tar.gz /var/TKLC/1sms/free
Password: <root_password>

# scp -p root@<rRemote IP>:<Remote IP Path>/supDBdump.sql
/var/TKLC/1sms/free
Password: <root_password>

# scp -p root@<Remote IP>:<Remote IP Path>/
MySQLUserGrants.sql /var/TKLC/1sms/free

Password: <root_password>

3. MPS A server:

Create DB schema for all
regional DB for which
restore needs to be done

Switch user to Ismsadm and create regional DB for all regions that were
connected to LSMS before migration
# su — Ismsadm

$ npac_db_setup create <region name>

Note: Run above command for all regions

MPS A and B server:
[] | Stop LSMS processes

b

Confidential

Note: Execute this step on Standby LSMS server first followed by the active
LSMS server.

# su - Tsmsmgr

4| Main Menu Ii

Initial Configuration

Diagno=stics

Server Configuration
Hetwork Configuration
Exit

—] Maintenance Menu |—

L5SM5 Node Status
Start HNode

Stop Node

Inhibit Node
Backup and Restore
Exit

I Stop HNode I

This could cause a service interruption, are you sure?
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Hode shutdown completed successfully.

Press any key to continme. ..

Exit the Ismsmgr menu.

>

MPS A and B:

Execute the “hastatus”
command to verify the HA
state of this server.

Execute the following command on both LSMS A and B to verify the HA state of
mated LSMS pair.

# hastatus
Verify that the hastatus of both the servers is ‘UNINITIALIZED "INHIBITED" .
WARNING: If the output from the above command is anything else other, do not

proceed with this procedure and contact My Oracle Support following the
instructions on the Appendix E.

MPS A server:

Extract the snapshot data
from the archive tar files
copied from LSMS.

# cd /var/TKLC/1sms/free

Restore the <regionDB> with the regional database name (For example:

CanadaDB)
# tar -xzvf /var/TKLC/1sms/free/mysql-snapshot-
<regionDB>.tar.gz

# scp /var/TKLC/1sms/free/<regionDB>/*MY*
/var/TKLC/1sms/db/<regionDB>

# rm -rf /var/TKLC/Isms/free/<regionDB>

&

MPS A server:

Restore supDB and MySQL
Users.

Run the following commands:
# systemct]l start mysqgld

Restore the ‘supDB’
# mysql -udbroot -p[dbroot_password] supDB <
/var/TKLC/Tsms/free/supDBdump.sql

Restore MySQL users
# mysql -udbroot -p[dbroot_password] <
/var/TKLC/Tsms/free/MySQLUserGrants.sql

# systemct]l stop mysqld
Note: The following warning message can be ignored if displayed:

Warning: Using a password on the command line interface can
be insecure.
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MPS A server:
] | Remove the snapshot files

~

Remove the shapshot files.

# cd /var/TKLC/1sms/free

# rm -f mysql-snapshot-*

# rm —f supDBdump.sql

# rm -f MysQLUserGrants.sql

MPS A server:

] | Check ownership of
database files

®

Verify dbadm:dbadm ownership of all database files and
directories.

# cd /var/TKLC/1sms/db
# 1s -1tr <DB Name>

where <DB NAME> is supDB or <region>DB,
where <region> is the name of an NPAC region.

If any databases have ownership other than dbadm:dbadm, change them using
this command:

# chown -R dbadm:dbadm <DB NAME>

MPS A and B server:
[] | Start LSMS processes

e

Note: Execute this step on LSMS A server first followed by LSMS B server.

# startNode

10. | MPS A and B:
] | System Heath Check

Execute Procedure 17to verify the system health check after DB full upgrade.

11. | LSMS Active server:
[] | Login to LSMS GUI

Login to LSMS Active GUI as Ismsall user.

12. | LSMS Active server:
] | Configure MySQL Port

Refer to the recorded value of MySQL Port in 29Procedure 6step 0.

If the MySQL Port is default port, then skip the next step.

Otherwise, go to “Admin -> MySQL Port -> Modify” and configure the port
recorded from LSMS 13.5.X.

13. | LSMS Active server:

] | Verify the ELAP
Credentials

Go to “Configure -> LNP System -> EMS -> View” to verify the ELAP
Credentials are identical to the recorded value of the ELAP Credentials in
Procedure 6step 11.

Otherwise, go to “Configure -> LNP System -> EMS -> Modify” and configure
the ELAP Credentials recorded from LSMS 13.5.X.

Note: Re-configure the EMS on LSMS with the details captured in Procedure 6,
step 7.

This procedure is complete!

Confidential - Oracle Restricted




Confidential - Oracle Restricted

Full Upgrade for LSMS 14.0

Software Upgrade Procedure

Procedure 20 CONNECT LSMS 14.0.X TO NPAC

Procedure 20 - Connect LSMS to NPAC

H U m-+Hw

This procedure connects the LSMS to the NPAC.

Estimated time:15 minutes

NOTE: Execute this procedure only when the NPAC region is not visible on the LSMS GUI, after the DB is restored.

—_

MPS X:
Verify LSMS installation

Note:

1. LSMS 14.0.X is successfully installed and configured.
2. NAS is successfully installed and configured.

LSMS Active server:
Login to LSMS Active GUI

Login to LSMS Active GUI through VIP as Ismsall user.

LSMS Active server:
Update NPAC Customer ID
if required

Note: If after restore NPAC
ID is coming as it was
before starting upgrade skip
this step

Click on the NPAC region.

Go to the menu Configure -> LNP System -> LSMS -> Modify

Enter the new LNP SPID in the ‘NPAC Customer ID’ field and fill appropriate
information in all other fields.

Mo dify LMP Systern LSS

HPAC Customer ID

Cainpeaieil o Coftact Info
System Type LEME O 1D THLI
PlatTorm Type LEMS Platform Supplier Dracle

PlatTorm SW Release (122 PlatTorm kol 1

23 Boddify LSMS Component T

(81, Caani i

>

LSMS Active server:
Create NPAC region(s) and
connect it to the NPAC

Click on the NPAC region.

Go to the menu Configure -> LNP System -> NPAC -> Modify -> Primary
Enter the NPAC IP in the ‘NSAP’ field and NPAC FTP Address and check the
‘Activate Region’ checkbox. Fill the information in all other tabs.
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Procedure 20 - Connect LSMS to NPAC

i Modify LNP Systern NPAC <MidAtlantic, primary> (25

SMS Name |Mid-Aflantic Regional MPAC SMS

Address Info Component Info Contact Info Comm Info

MPAC OS5 Address

v| Activate Region

PSEL |owl SSEL |owl TSEL MSAP |10 248 (10 |5

Lims O8] Address

PSEL psel 55EL ssel TSEL MN3&F 10 248 10 FE

MPAC FTP Address

10 |248 |10 |5

E Modify NPAC Component?

Ok Cancel

This procedure is complete!

Procedure 21EXPORT THE DATABASE FROM LSMS 14.0.X TO THE QUERY SERVER

Procedure 21 — Export the Database from LSMS 14.0.X to the Query Server

H UOm-+Hw

This procedure provides the steps to export the database from the LSMS 14.0.X system to the query server.
Estimated time:30 minutes

LSMS Active server:
] | Login as root.

[,

Login to LSMS 14.0.X CLI as root user.

LSMS Active server:

[] | Remove the existing DB
snapshot files

»

# rm /var/TKLC/lsms/free/mysql-snapshot-*
# rm /var/TKLC/lsms/free/snapinfo.sql

3. LSMS Active server:
[] | Create a snapshot

# Ismsdb -c snapshot

WARNING: This command may cause a brief interruption in
traffic being sent

from the NPAC to connected network elements and Tocal LSMS
provisioning may be INTERRUPTED.

Do you want to continue? [Y/N]Y

Creating snapshot of the database partition, please wait...
lvcreate -- WARNING: the snapshot will be automatically
disabled once it gets full

Tvcreate -- INFO: using default snapshot chunk size of 64 KB
for "/dev/vgapp/dbbackup"

Tvcreate -- doing automatic backup of "vgapp”

lvcreate -- logical volume "/dev/vgapp/dbbackup"
successfully created

The database is available to the application again.

Confidential - Oracle Restricted




Confidential - Oracle Restricted

Full Upgrade for LSMS 14.0

Software Upgrade Procedure

Procedure 21 — Export the Database from LSMS 14.0.X to the Query Server

D1sk snhapshot created successtully.
mount: block device /dev/vgapp/dbbackup is write-protected,
mounting read-only

Snapshot mounted successfully.

Created snapinfo.sql file successfully
CanadaDB/

CanadabDB/db.opt
CanadabDB/Subscriptionversion.frm
CanadabDB/Subscriptionversion.MYI
CanadabDB/Subscriptionversion.MYD
CanadabDB/NumberpPool1Block.frm
CanadabDB/NumberpPoo1Block.MYI
CanadabDB/NumberpPool1Block.MYD
CanadaDB/ServiceProvNetwork.frm
CanadaDB/ServiceProvNetwork.mMYI
CanadaDB/ServiceProvNetwork.MYD
CanadaDB/ServiceProvLRN.frm
CanadaDB/ServiceProvLRN.MYI

f%runcated )
Tvremove -- doing automatic backup of volume group "vgapp"
Tvremove -- logical volume "/dev/vgapp/dbbackup"

successfully removed

LSMS Active server:
[] | Verify the snapshot

>

# cd /var/TKLC/1sms/free

[root@Ismspri freel# 1s
mysqgl-snapshot-SouthwestDB.tar.gz
mysql-snapshot-supDB.tar.gz
mysqgl-snapshot-CanadabDB. tar.gz
mysql-snapshot-westCoastDB.tar.gz
mysqgl-snapshot-MidAtTlanticDB.tar.gz
shapinfo.sql
mysqgl-snapshot-MidwestDB. tar.gz
mysqgl-snapshot-NortheastDB.tar.gz
mysqgl-snapshot-SoutheastDB.tar.gz

5. LSMS Active server:

] | Copy snapshot files to
LSMS 14.0.X Query Server
or a Remote Server.

Transfer all the NPAC region DB snapshot files.

Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,
NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB

# scp -p Svar/TKLC/1sms/free/mysqi-snapshot-<NPAC
region>.tar.gz root@<Query Server IP>:/usr/mysqll

# scp -p /var/TKLC/1sms/free/snapinfo.sql root@<Query
Server IP>:/usr/mysqll

or

# sftp <username>@<IP address of remote computer>
Connecting to <IP address of remote computer>...

The authenticity of host '<IP address of remote computer>'
can't be established.

DSA key fingerprint is
58:a5:7e:1b:ca:fd:1d:fa:99:f2:01:16:79:d8:b4:24.

Are you sure you want to continue connecting (yes/no)? yes
warning: Permanently added '<IP address of remote computer>'
(DSA) to the 1ist of known hosts.

<username>@<IP address of remote computer>'s password:

sftp> cd <target directory>

sftp> put mysql-snapshot-<NPAC region>.tar.gz
Uploading mysql-snapshot-<NPAC region>.tar.gz
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sftp> put snapinfo.sql
Uploading snapinfo.sql
sftp> bye

|:|.°\

LSMS 14.0.X Query
Server:

Login as root to the Query
Server

login: root
Password:<root_password>

# cd /opt/mysql/mysql/bin

Extract the data for EACH
region. Replace regionDB
with regional database name

Remove each tar.gz after it
has extracted.

7. | LSMS 14.0.X Query
[] | Server: # ./mysqladmin -u root -p shutdown
Shutdown the Mysgl server | Enter password:
8. | LSMS 14.0.X Query # cd /usr/mysqll
[ | Server: # gunzip -c mysql-snapshot-<regionDB>.tar.gz | tar -xvf -

# rm mysql-snapshot-<regionDB>.tar.gz

intermediate tarballs from
the LSMS 14.0.X server.

As the root user, remove the
snapinfo.sql script from the
LSMS 14.0.X server

9. LSMS 14.0.X Query # cd /opt/mysql/mysql/bin
] Server:
Start the Mysql daemon on
the Query Server. # ./mysqld_safe --skip-slave-start &
1255
# Starting mysqld daemon with databases from /usr/mysqll:
10. | LSMS 14.0.X Query # ./mysql -u root -p
] Server:
S_tart thg Mysql command mysql> reset master;
line utility Query OK, 0 rows aﬁz’ected (0.23 sec)
Reset the configuration
information for master
mysql> reset slave;
Query OK, 0 rows affected (0.19 sec)
Reset the configuration
information for slave mysql> source /usr/mysqll/snapinfo.sql
Query OK, 0 rows affected (0.17 sec)
Configure the query server
to start replication from the
correct position on the
master.
LSMS Active server: As
11. . _
B the root user, remove the [root@Ismspri root]l# rm /var/TKLC/1sms/free/mysql-snapshot*

[root@Ismspri root]# rm /var/TKLC/1sms/free/snapinfo.sql
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12. | LSMS 14.0.X Query NOTE:

] Server: EMS changes may cause the Query server to disconnect. These
Start the Mysgl command steps will help prevent the disconnect.

line utility login: root
# /opt/mysql/mysql/bin/mysgl -u root —p

13. | LSMS 14.0.X Query mysql> SET GLOBAL SQL_SLAVE_SKIP_COUNTER = 100;
[] | Server: Query OK, 0 rows affected

Prepare the Query Server
for the EMS Configuration

14. | LSMS 14.0.X Query
] Server:

Validate the operation of the
query server.

Perform Error! Reference source not found..

This procedure is complete!

Procedure 22SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

Procedure 22 - SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

STEP | This procedure exchanges SSH keys between the ELAP and LSMS 14.0 (TPD 8) .
#

Note: Estimated time of completion is 15 minutes.
Check off (V) each step as it is completed. Boxes have been provided for this purpose under each step number.

Should this procedure fail, Contact Oracle technical services and ask for FULL UPGRADE ASSISTANCE.

. . login: elapdev
L. Active ELAP: Password: <elapdev_password>
Login as elapdev.

) Active ELAP: NOTE: RSA keys don’t exist on OL6 server ELAP 10.2. To
: : exchange keys with LSMS 14, we need to generate RSA keys
Generate RSA keys on first on ELAP 10.2 server.

ELAP 10.2 server

Please run below commands on the Active ELAP to generate
RSA keys on ELAP A and B servers.

1. Go to elapdev home directory using cd command.
cd

2. Generate key on Tocal ELAP.
/usr/bin/ssh-keygen -t rsa -f .ssh/id_rsa -N "'
3. Generate key on remote ELAP

“ssh mate "/usr/bin/ssh-keygen -t rsa -f .ssh/id_rsa -N

Example:
[elapdev@Iithaca-A ~]$ cd

[elapdev@Iithaca-A ~]$ /usr/bin/ssh-keygen -t rsa -f
.ssh/id_rsa -N "'
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Procedure 22 - SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

Generating public/private rsa key pair.

Your identification has been saved in .ssh/id_rsa.
Your public key has been saved in .ssh/id_rsa.pub.
The key fingerprint is:

3e:d0:ea:25:fc:84:66:ff:4c:16:00:16:99:c8:ed:af
elapdev@ithaca-A

The key's randomart image is:
+--[ RSA 2048]----+
. O++

0.+.

I I
I I
I I
I e I
| ..S . |
I I
I I
I I
I I

[eTapdev@Ithaca-A ~]# ssh mate "/usr/bin/ssh-keygen -t rsa
-f .ssh/id_rsa -N "' “

3. Active ELAP:

Verify that the keys are
generated for elapdev user
on both ELAP A and B
serves.

Check that rsa keys are generated for the elapdev user on
local and mate using below command.

Run below commands to verify the keys.
$ 1s -1rt .ssh/id_rsa*
$ ssh mate '1s -1rt .ssh/id_rsa*’

Example:

[eTapdev@Crete-A ~]$ 1s -1rt .ssh/id_rsa*

-rw-r--r-- 1 elapdev elap 569 Mar 20 08:16 .ssh/id_rsa.pub
-rw------- 1 elapdev elap 2602 Mar 20 08:16 .ssh/id_rsa
[eTapdev@Crete-A ~]$ ssh mate 'ls -Trt .ssh/id_rsa*'
-rw-r--r-- 1 elapdev elap 569 Mar 20 08:17 .ssh/id_rsa.pub
-rw------- 1 elapdev elap 2602 Mar 20 08:17 .ssh/id_rsa
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Procedure 22 - SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

4,

Active ELAP:
Exchange Secure Shell
Keys with LSMS 14.0

SSH keys will first be
exchanged between ELAP A
and LSMS A and then
between ELAP B and LSMS
A.

Exchange secure shell keys with LSMS A server using below
command.
Run below commands to exchange keys with LSMS.

1. Exchange key with local ELAP and LSMS.

/usr/TKLC/plat/bin/keyexchange 1smsadm@lsmsAIpAddr --
key=1d_rsa.pub 2>&1

2. Exchange Key with remote ELAP and LSMS
/usr/bin/ssh -1 elapdev mate -t

"/usr/TKLC/plat/bi n/keyexchange Tsmsadm@]smsAIpAddr --
key=1d_rsa.pub 2>&1'

Example:

[eTapdev@Ithaca-A ~]$ /usr/TKLC/plat/bin/keyexchange
Ismsadm@10.75.140.10 --key=id_rsa.pub 2>&1

The server does not know of 10.75.140.10.

will just exchange host keys for the name given!
Password of 1smsadm:

ssh is working correctly.

Active ELAP:
Exchange Secure Shell
Keys with LSMS 14.0

SSH keys will next be
exchanged between ELAP A
and LSMS B and then
between ELAP B and LSMS
B

Exchange secure shell keys with LSMS B server using below
command.

Run below commands to exchange keys with LSMS.
1. Exchange key with local ELAP and LSMS.

/usr/TKLC/plat/bin/keyexchange 1smsadm@lsmsBIpAddr --
key=1d_rsa.pub 2>&1

2. Exchange Key with remote ELAP and LSMS
/usr/bin/ssh -1 elapdev mate -t

"/usr/TKLC/p1 at/b1 n/keyexchange 1smsadm@] smsBIpAddr --
key=1d_rsa.pub 2

Example:

[eTapdev@Ithaca-A ~]$ /usr/TKLC/plat/bin/keyexchange
Ismsadm@10.75.140.11 --key=id_rsa.pub 2>&1

The server does not know of 10.75.140.10.

will just exchange host keys for the name given!
Password of Tsmsadm:

ssh is working correctly.

Active ELAP:

Note down date and
timestamp

$date

This procedure is complete!
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Procedure 23 CONNECT LSMS 14.0.X TO ELAP

Procedure 22 - Connect LSMS to ELAP

? This procedure connects the LSMS to ELAP.
E | Estimated time:10 minutes
P
#
7. | ELAP Active server: Lodin to ELAP GUI th HVIP dmi
7 | Login to ELAP GUI ogin to throug as uiadmin.
8. ELAP Active server: Got Maint LSMS C i ch Enabled
0 to menu Maintenance -> onnection -> Change Enable
[ | Enable the LSMS Click on ‘Enable LSMS Connection’ button.
Connection
ELAP_A_NAME Change LSMS Connection Allowed
i INFO: The LSMS Connection is currently Disabled.
A CAUTION: This action will Enable the LSMS Connection
2013 @ Tekelec, Inc., All Rights Reserve d.
ELAP_A_NAME Change LSMS Connection Allowed
V SUCCESS: The L3MS3 Connection is now Enabled.
Fri December 27 2013 02:03:19 EST P rORE—
9 | ELAP Active server: Go to menu Maintenance -> LSMS HS Bulk Download -> Change Enabled
Click on ‘Enable LSMS Bulk Download for the ELAP’ button.
Enable the bulkload.
ELAP_B_NAME Change LSMS HS Bulk Download Enabled
i INFO: The LSMS Bulk Download for this ELAP is currently Disabled.
A CAUTION: This action will Enable the LSMS Bulk Download for this ELAP.
Enable LSMS Bulk Download for this ELAP
e Copyright © 2013-2016, Oracle andior its affiliates. All rights reserved.
After clicking on the button,success message will be displayed.
SUCCESS The LSMS HS Bulk Download is now enabled.
This procedure is complete!

Procedure 24 ACCEPT THE UPGRADE

Procedure 23 — Accept the upgrade.

This procedure will accept the upgrade.
Estimated time: 5 minutes

HFTOmM-Aw
>
@
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Procedure 23 — Accept the upgrade.

1. MPS X: Log in to the server
Ol O as the user “root”.

Login: root
Password: <root_password>

# su - platcfg

Main Menu

Diagnostics

Server Configuration
Hetwork Configuration
Eemote Consoles

Exit

2. MPS X: Start platcfg
Ol O utility.
3 MPS X: Accept Upgrade
Ol O On the “Main Menu”, select Maintenance and press [ENTER].

Select the “Upgrade” menu and press [ENTER].

Maintenance Menu

Backup and Restore

View Mail QCQueues

Restart Server

Save Platform Debug Logs
Exit

Select the “Accept Upgrade” menu and press [ENTER].

———————4 Upgrade Menu f————————

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USE Upgrade Image
Non Tekelec EPM Management

ccept Upgrade
Reject Upgrade
Exic

Note: The “Reject Upgrade” menu is also available after the LSMS installation.
However, this option should not be used after the first installation of application. It
should be used in subsequent upgrades to return to a previous application release.

Select Yes and press [ENTER].
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Procedure 23 — Accept the upgrade.

Full Upgrade for LSMS 14.0

Main Menu

Do you really want to accept the upgrade?

This procedure is complete!
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APPENDIX A. ISO IMAGE COPY FROM USB MEDIA

Assumption: The USB media contains the desired LSMS ISO.

A.1 1ISO IMAGE COPY FROM USB MEDIA

Appendix A.1 - ISO Image copy from USB media

S This procedure provides instructions to copy an 1SO image from an USB media.
T
E|1A | 1B
P
#
.00 B/ISPE? X: Insert Insert media in USB drive
2 olo Mpé X: Loginto | [hostname] consolelogin: root
the server as the password: password
“root” user.
3. OO MPS X: Run Execute the following command:
syscheck to make | # syscheck
sure there is no The output should Tlook Tike:
error. [root@hostname ~]# syscheck
Running modules in class proc...
OK
Running modules in class services...
OK
Running modules in class system...
OK
Running modules in class disk...
OK
Running modules in class hardware...
OK
Running modules in class net...
OK
LOG LOCATION: /var/TKLC/log/syscheck/fail_log
4, OO MPS X: Verify 1SO| Execute the following command to perform directory listing:
image doesn’t # 1s -al /var/TKLC/upgrade
already exist. The output should look like:
[root@hostname ~]# 1s -al /var/TKLC/upgrade
total 16
dr-xr-xr-x 2 root root 4096 Oct 22 16:31 .
dr-xr-xr-x 21 root root 4096 oct 18 13:40 ..
If an 1ISO image exists, remove it by executing the following command:
# rm -f /var/TKLC/upgrade/<ISO image>
51010 |MPSX: Delete Execute the foIIowin}g command to create a directory to mount the USB media:
unwanted 1SOs # mkdir -p /mnt/usb
from USB media. ) )
Execute the following command to get the USB drive name:
# fdisk -1 |grep FAT
The output should look like:
/dev/sdcl * 1 812 831472 6
FAT16
Execute the following command to mount the USB media using the USB drive
name from the output above:

Full Upgrade for LSMS 14.0

Confidential - Oracle Restricted

14.0 91 of 100




Confidential - Oracle Restricted

Software Upgrade Procedure

Full Upgrade for LSMS 14.0

# mount /dev/sdcl /mnt/usb

Execute the following command to perform directory listing and verify the file

name format is as expected:
# 1s -al /mnt/usb

The output should look like:

[root@hostname ~]# # 1s -al /mnt/usb

total 629400

dr-xr-xr-x 2 root root 4096 Dec 5 13:33 .

dr-xr-xr-x 22 root root 4096 Dec 5 13:55 ..
-rw-r--r-- 1 root root 829595648 Dec 5 16:20 LSMS-
14.0.0.0.0_140.6.5-x86_64.1s00nly one ISO file should be listed, if
additional files are listed, execute the following command to remove unwanted

ISOs:
# rm —f /mnt/usb/<ISO_NAME>.iso

Fore.g.,
# rm -f /mnt/usb/ LSMS-14.0.0.0.0_140.6.5-x86_64.1iso

6. OO MPSX:_Verify
space exists for
ISO.

Execute the following command to verify the available disk space:

# df -h /var/TKLC

The output should Took Tike:
[root@Ismspri log]# df -h /var/TKLC
Filesystem Size Used Avail Use% Mounted on
/dev/mapper/vgroot-plat_var_tklc
3.9 1.2G 2.5G 32% /var/TKLC

Verify that there is at least 620M in the Avail column. If not, clean up files
until there is space available.

CAUTION: Make sure you know what files you can remove safely before
cleaning up. Itis recommended that you only clean up files in the
/var/TKLC/upgrade directory as this is a platform owned directory that
should only contain ISO images. This directory should not be expected to
contain images for any length of time as they can get purged. Contact
Technical Services beforehand if removing files other than the
Ivar/TKLC/upgrade directory as removing files is dangerous.

7.1 7 | Copy iso from
mounted path to

the destination
path

Execute the following command to copy ISO:
# cp /mnt/usb/<xyz.iso> /var/TKLC/upgrade/

Execute the following command to unmount the USB media:
# umount /mnt/usb

8. OO !\/IPS X: _Verify ISO
image exists.

Execute the following command to perform directory listing:
# Is —al /var/TKLC/upgrade

The output should look like:

The output should look like:
[root@lsmspri logl# 1s -al /var/TKLC/upgrade
total 895152

drwxrwxr-x. 2 root admgrp 4096 Apr 20 17:16 .
dr-xr-xr-x. 20 root root 4096 Apr 20 18:01 ..
-r-———-——- 1 admusr admgrp 916621312 Apr 20 17:16 LSMS-

14.0.0.0.0_140.6.5-x86_64.1iso0

Repeat this procedure from step 5 if LSMS ISO file is not as expected.
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9 || [J | MPS X: Logout Logout from the server by executing the following command:
from server.
# logout
10.| 7| 7 | MPS X: Remove | Remove media from USB drive.
USB media.

This procedure is complete!

A.2 Copying LSMS backups from NAS to USB

S This procedure provides instructions to copy LSMS backups from NAS to USB.
T
E | NAS
P
#
1.1 O NAS: Insert USB. | Insert media in USB drive
2. ] NAS: Log in to the | [hostname] consolelogin: root
server as the “root” | password: password
user.
3.1 [J | NAS:Run Execute the following command:
syscheck to make | # syscheck
sure there is no The output should Took 1Tike:
error. [root@hostname ~]# syscheck
Running modules in class proc...
oK
Running modules in class services...
oK
Running modules in class system...
oK
Running modules in class disk...
oK
Running modules in class hardware...
oK
Running modules in class net...
oK
LOG LOCATION: /var/TKLC/log/syscheck/fail_log
4.1 ] | NAS: Mount the Execute the following command to create a directory to mount the USB media:
USB media. # mkdir -p /mnt/usb
Execute the following command to get the USB drive name:
# fdisk -1 |grep FAT
The output should look like:
/dev/sdcl * 1 812 831472 6
FAT32
Execute the following command to mount the USB media using the USB drive
name from the output above:
# mount /dev/sdcl /mnt/usb
Note: There should be space available in the USB. If not, clean up files until
there is space available.
5. ] Copy backup files | Execute the following command to copy I1SO:
to the mounted # cp <backup files> /mnt/usb/
path
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While copying backup files to USB, Following error is expected:

cp: failed to preserve ownership for “/mnt/usb/<backup_file>": Operation
not permitted

Note: Please note the ownership of the backup files before copying.Therefore,
after restoring the backups to server after IPM’ing , verify the ownership of
backup files. If not matched, change the ownership with the “chown” command.

6.1 [] | NAS: Verify Execute the following command to perform directory listing:
backup files exists | # Is —al /mnt/usb/

List of backup files should be displayed.

Execute the following command to unmount the USB media:
# umount /mnt/usb

7. H NAS: Logout from | Logout from the server by executing the following command:

server.
# Togout
8. ] NAS: Remove Remove media from USB drive.
USB media.
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APPENDIX B. START AND VERIFY REPLICATION ON QUERY SERVER

Appendix B — Start and Verify REPLICATION ON Query Server

Query Server:
Start Replication.

Verify the replication
status on the Query
Server.

NOTE:

If the
Slave_IO_Running
and
Slave_SQL_Running
column values are set
to YES, the status is
good and the next
step can be skipped.

If the
Slave_1O_Running
and
Slave_SQL_Running
column values are set
to NO, wait a few
minutes and then
repeat the “show
slave status \G;”
command

If the values are still
NO, proceed to the
next step.

mysql> start slave;

S | This procedure provides the steps to start and verify Replication on the query server
T

E | This step is performed only if a query server exists in the customer system.

P | Estimated time:30 minutes

#
1. | LSMS14.0.X

Query OK, 0 rows affected (0.00 sec)

mysql> show slave status \G;

Slave_IO_State:
Master_Host:
Master_User:
Master_Port:

connect_Retry:
Master_Log_File:
Read_Master_Log_Pos:
Relay_Log_File:
Relay_Log_Pos:
Relay_Master_Log_File:
Slave_IO_Running:
Slave_SQL_Running:
Replicate_Do_DB:
Replicate_Ignore_DB:
Replicate_Do_Table:
Replicate_Ignore_Table:

JORORORORONOORORORON

. row THR RN AN Sedededededddh
waiting for master to
<Master Host IP>
Tsmsrepl

3306

60

mysql-bin.000134
15778725
cs2-bss2-relay-bin.000001
4137221

mysql-bin.000134

Yes

Yes

TSNSl dddn

send event

ResyncDB,mysq]l

SUupDB.LsmsUserSpid, supDB.LsmsUser,supDB.DbConfig

Replicate_wild_Do_Table:
Replicate_wild_Ignore_Table:
Last_Errno:
Truncated
Seconds_Behind_Master:
1 row in set (0.00 sec)
mysql1>

ResyncDB.%, supDB.%Key,mysql.%
1008

NULL
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2.

O

LSMS 14.0.X
Query Server:

OPTIONAL:

If the
Slave_IO_Running
and
Slave_SQL_Running
column values are set
to NO, the status is
not good and the
error will need to be
investigated.

Look at last few lines
of error log, and
record the error.

# tail /usr/mysqll/*.err

Record error here:

Contact My Oracle Support following the instructions on the Appendix E and ask for
FULL UPGRADE ASSISTANCE.

w

LSMS Active
Server:

Login to the LSMS
Primary server as
Ismsadm.

Verify the Query
Server is Connected.

Login: Tsmsadm
Password: <1smsadm_password>

[1smsadm@lsmspri Tsmsadm]$ Tsmsdb -c queryservers
cs2-bss2 (<Query Server IP>) Connected
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APPENDIX C. COPYING LICENSE FILE ON THE LSMS SERVER

C.1 Copying File Using SCP

S | This procedure will help copying the license file from a desktop to LSMS server
T
E
P
#
1. | Server X: Login to Loging to server using ID and password where license file is copied
[J| server where license file
is present
2. | server X: SCP the file | scp <license file> root@<LSMS IP>: /usr/local/netech/etc/Ticense
L] from server to LSMS
server
3. | LSMS MPS: Check if | Run command to check for license file :
L the license file has been| $ cat /usr/local/netech/etc/license
copied correctly Expected Output : _
Contents of license file should be displayed
This procedure is complete!
C.2 Copying File Using USB
S | This procedure will help copying the license file from a desktop to LSMS server
T
E
P
#
1. Server X: Copy license | Connect USB to desktop and copy the license file from desktop to USB.
L] file to USB
2. | LSMS MPS: Confirm | Connect the USB to LSMS MPS which contains the license file and check on how it is
L] how the USB is enumerated using command :
enumerated on LSMS | $dmesg | grep -i "removable disk"
server Expected output
sd 6:0:0:0: Attached scsi removable disk sdc
This shows USB is enumerated as /dev/sdc
3. | LSMS MPS: Determine| Run command fdisk —I on enumerated name device to determine partition name :
L] the partition name $fdisk —I /dev/sdc
Expected Output :
Disk /dev/sdc: 2013 MB, 2013265920 bytes
256 heads, 63 sectors/track, 243 cylinders
Units = cylinders of 16128 * 512 = 8257536 bytes
Device Boot Start End Blocks Id System
/dev/sdcl * 1 110 887008+ b w95 FAT32
This shows that partition name is /dev/sdcl
Full Upgrade for LSMS 14.0
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LSMS MPS: Copy
license file from USB to
MPS

Run below command to copy the license file from USB
$mkdir -p /tmp/usb
$ mount /dev/sdcl /tmp/usb

LSMS MPS: Copy
license file from /tmp
directory

$ cp /tmp/usb/<1license-file> /usr/local/netech/etc/Ticense

LSMS MPS: Check if
the license file has been
copied correctly

Run command to check for license file :
$ cat /usr/local/netech/etc/1icense

Expected Output :
Contents of license file should be displayed

>

LSMS MPS: Unmount
the USB

Unmount the USB using command :
$umount /tmp/usb

This procedure is complete!
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APPENDIX D. SWOPS SIGN OFF.

Software Upgrade Procedure

Discrepancy List
Date Test Description of Failures and/or Issues. Resolution and SWOPS Resolution
Case Any CSR’s /| RMA’s issued during Engineer Responsible Date:
Acceptance. Discrepancy
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APPENDIX E. MY ORACLE SUPPORT

ACAUTION: Use only the guide downloaded from the Oracle Technology Network (OTN)
(http://www.oracle.com/technetwork/indexes/documentation/oracle-comms-tekelec-2136003.html).

Before upgrading your system, access the My Oracle Support web portal (https://support.oracle.com) and review any
Knowledge Alerts that may be related to the System Health Check or the Upgrade.

Before beginning this procedure, contact My Oracle Support and inform them of your upgrade plans. If installing for an
Oracle customer on a customer site, obtain the customer's Support Identifier (SI) before requesting assistance.

Web portal (preferred option): My Oracle Support (MOS) (https://support.oracle.com/)

Phone: Contact your local Oracle Global Customer Support Center (http://www.oracle.com/support/contact.html)
Make the following selections on the Support telephone menu:

1. Select ‘2’ for New Service Request
2. Select ‘3’ for Hardware, Networking and Solaris Operating System Support

3. Select ‘1’ for Technical Issues and when talking to the agent, please indicate that you are an existing
Tekelec customer
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